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Terms for Included Open 
Source Software 
This document contains information respecting free and open-
source software (collectively, “FOSS”) included in or provided 
with the product (“Product”) that this document accompanies. 
Any terms, conditions, and restrictions governing the use or 
distribution of FOSS that are offered or imposed by SAP and are 
not contained within the FOSS license(s) governing the use and 
distribution of the FOSS, are offered and imposed by SAP alone. 
The authors, licensors, and distributors of the FOSS have 
disclaimed all warranties relating to any liability arising from the 
use and distribution of the FOSS. 
While SAP has sought to provide a complete and accurate listing 
of the FOSS components included in or provided with the 
Product, SAP does not represent or warrant that the listing of 
FOSS components and associated notices and licensing 
information provided herein are complete or error-free. Recipients 
of the Product should investigate the listed FOSS components to 
confirm the accuracy of the notices and licensing information 
provided herein. Recipients are encouraged to notify SAP of any 
inaccurate information or errors found in this document. 
If you have any questions or concerns please contact SAP by 
email at opensource@sap.com or via mail at Dietmar Hopp Allee 
16, 69190 Walldorf, Germany, Attn: Global Legal. 
Mozilla SpiderMonkey 
Licensor: Mozilla Developer Network and individual 
contributorsWebsite: developer.mozilla.org/en-
US/docs/Mozilla/Projects/SpiderMonkeyLicense: Mozilla Public 
License version 2.0 
 
Component: Mozilla SpiderMonkey 
Licensor: Mozilla Developer Network and individual contributors 
Website: https://developer.mozilla.org/en-
US/docs/Mozilla/Projects/SpiderMonkey  
License: Mozilla Public License version 2.0 
 
1. Definitions 
1. “Contributor” 
means each individual or legal entity that creates, contributes to 
the creation of, or owns Covered Software. 
2. “Contributor Version” 
means the combination of the Contributions of others (if any) 
used by a Contributor and that particular Contributor’s 
Contribution. 
3. “Contribution” 
means Covered Software of a particular Contributor. 
4. “Covered Software” 

means Source Code Form to which the initial 
Contributor has attached the notice in Exhibit A, 
the Executable Form of such Source Code Form, 
and Modifications of such Source Code Form, in 
each case including portions thereof. 
5. “Incompatible With Secondary Licenses” 
means 
1. that the initial Contributor has attached the 
notice described in Exhibit B to the Covered 
Software; or  
2. that the Covered Software was made 
available under the terms of version 1.1 or earlier 
of the License, but not also under the terms of a 
Secondary License. 
6. “Executable Form” means any form of the 
work other than Source Code Form. 
7. “Larger Work”  
means a work that combines Covered Software 
with other material, in a separate file or files, that 
is not Covered Software. 
8. “License” 
means this document. 
9. “Licensable” 
means having the right to grant, to the maximum 
extent possible, whether at the time of the initial 
grant or subsequently, any and all of the rights 
conveyed by this License. 
10. “Modifications” 
means any of the following: 
1. any file in Source Code Form that results 
from an addition to, deletion from, or 
modification of the contents of Covered 
Software; or 
2. any new file in Source Code Form that 
contains any Covered Software. 
11. “Patent Claims” of a Contributor 
means any patent claim(s), including without 
limitation, method, process, and apparatus 
claims, in any patent Licensable by such 
Contributor that would be infringed, but for the 
grant of the License, by the making, using, 
selling, offering for sale, having made, import, or 
transfer of either its Contributions or its 
Contributor Version. 
12. “Secondary License” 
means either the GNU General Public License, 
Version 2.0, the GNU Lesser General Public 
License, Version 2.1, the GNU Affero General 



   

Public License, Version 3.0, or any later versions of those 
licenses. 
13.  “Source Code Form” 
means the form of the work preferred for making modifications. 
14.  “You” (or “Your”) 
means an individual or a legal entity exercising rights under this 
License. For legal entities, “You” includes any entity that 
controls, is controlled by, or is under common control with You. 
For purposes of this definition, “control” means (a) the power, 
direct or indirect, to cause the direction or management of such 
entity, whether by contract or otherwise, or (b) ownership of more 
than fifty percent (50%) of the outstanding shares or beneficial 
ownership of such entity. 
2. License Grants and Conditions 
1.  Grants 
Each Contributor hereby grants You a world-wide, royalty-free, 
non-exclusive license: 
1. under intellectual property rights (other than patent or 
trademark) Licensable by such Contributor to use, reproduce, 
make available, modify, display, perform, distribute, and 
otherwise exploit its Contributions, either on an unmodified basis, 
with Modifications, or as part of a Larger Work; and 
2. under Patent Claims of such Contributor to make, use, sell, 
offer for sale, have made, import, and otherwise transfer either its 
Contributions or its Contributor Version. 
2. Effective Date 
The licenses granted in Section 2.1 with respect to any 
Contribution become effective for each Contribution on the date 
the Contributor first distributes such Contribution. 
3. Limitations on Grant Scope 
The licenses granted in this Section 2 are the only rights granted 
under this License. No additional rights or licenses will be 
implied from the distribution or licensing of Covered Software 
under this License. Notwithstanding Section 2.1(b) above, no 
patent license is granted by a Contributor: 
1. for any code that a Contributor has removed from Covered 
Software; or 
2. for infringements caused by: (i) Your and any other third 
party’s modifications of Covered Software, or (ii) the 
combination of its Contributions with other software (except as 
part of its Contributor Version); or 
3. under Patent Claims infringed by Covered Software in the 
absence of its Contributions. 
This License does not grant any rights in the trademarks, service 
marks, or logos of any Contributor (except as may be necessary to 
comply with the notice requirements in Section 3.4). 
4. Subsequent Licenses 

No Contributor makes additional grants as a 
result of Your choice to distribute the Covered 
Software under a subsequent version of this 
License (see Section 10.2) or under the terms of 
a Secondary License (if permitted under the 
terms of Section 3.3). 
5. Representation 
Each Contributor represents that the Contributor 
believes its Contributions are its original 
creation(s) or it has sufficient rights to grant the 
rights to its Contributions conveyed by this 
License. 
6. Fair Use 
This License is not intended to limit any rights 
You have under applicable copyright doctrines of 
fair use, fair dealing, or other equivalents. 
7. Conditions 
Sections 3.1, 3.2, 3.3, and 3.4 are conditions of 
the licenses granted in Section 2.1. 
3. Responsibilities 
1. Distribution of Source Form 
All distribution of Covered Software in Source 
Code Form, including any Modifications that 
You create or to which You contribute, must be 
under the terms of this License. You must inform 
recipients that the Source Code Form of the 
Covered Software is governed by the terms of 
this License, and how they can obtain a copy of 
this License. You may not attempt to alter or 
restrict the recipients’ rights in the Source Code 
Form. 
2. Distribution of Executable Form 
If You distribute Covered Software in 
Executable Form then: 
1. such Covered Software must also be made 
available in Source Code Form, as described in 
Section 3.1, and You must inform recipients of 
the Executable Form how they can obtain a copy 
of such Source Code Form by reasonable means 
in a timely manner, at a charge no more than the 
cost of distribution to the recipient; and 
2. You may distribute such Executable Form 
under the terms of this License, or sublicense it 
under different terms, provided that the license 
for the Executable Form does not attempt to limit 
or alter the recipients’ rights in the Source Code 
Form under this License. 
3. Distribution of a Larger Work 



   

You may create and distribute a Larger Work under terms of Your 
choice, provided that You also comply with the requirements of 
this License for the Covered Software. If the Larger Work is a 
combination of Covered Software with a work governed by one 
or more Secondary Licenses, and the Covered Software is not 
Incompatible With Secondary Licenses, this License permits You 
to additionally distribute such Covered Software under the terms 
of such Secondary License(s), so that the recipient of the Larger 
Work may, at their option, further distribute the Covered Software 
under the terms of either this License or such Secondary 
License(s). 
4. Notices 
You may not remove or alter the substance of any license notices 
(including copyright notices, patent notices, disclaimers of 
warranty, or limitations of liability) contained within the Source 
Code Form of the Covered Software, except that You may alter 
any license notices to the extent required to remedy known factual 
inaccuracies. 
5. Application of Additional Terms 
You may choose to offer, and to charge a fee for, warranty, 
support, indemnity or liability obligations to one or more 
recipients of Covered Software. However, You may do so only on 
Your own behalf, and not on behalf of any Contributor. You must 
make it absolutely clear that any such warranty, support, 
indemnity, or liability obligation is offered by You alone, and 
You hereby agree to indemnify every Contributor for any liability 
incurred by such Contributor as a result of warranty, support, 
indemnity or liability terms You offer. You may include 
additional disclaimers of warranty and limitations of liability 
specific to any jurisdiction. 
4. Inability to Comply Due to Statute or Regulation 
If it is impossible for You to comply with any of the terms of this 
License with respect to some or all of the Covered Software due 
to statute, judicial order, or regulation then You must: (a) comply 
with the terms of this License to the maximum extent possible; 
and (b) describe the limitations and the code they affect. Such 
description must be placed in a text file included with all 
distributions of the Covered Software under this License. Except 
to the extent prohibited by statute or regulation, such description 
must be sufficiently detailed for a recipient of ordinary skill to be 
able to understand it. 
5. Termination 
1. The rights granted under this License will terminate 
automatically if You fail to comply with any of its terms. 
However, if You become compliant, then the rights granted under 
this License from a particular Contributor are reinstated (a) 
provisionally, unless and until such Contributor explicitly and 
finally terminates Your grants, and (b) on an ongoing basis, if 

such Contributor fails to notify You of the non-
compliance by some reasonable means prior to 
60 days after You have come back into 
compliance. Moreover, Your grants from a 
particular Contributor are reinstated on an 
ongoing basis if such Contributor notifies You of 
the non-compliance by some reasonable means, 
this is the first time You have received notice of 
non-compliance with this License from such 
Contributor, and You become compliant prior to 
30 days after Your receipt of the notice. 
2. If You initiate litigation against any entity 
by asserting a patent infringement claim 
(excluding declaratory judgment actions, 
counter-claims, and cross-claims) alleging that a 
Contributor Version directly or indirectly 
infringes any patent, then the rights granted to 
You by any and all Contributors for the Covered 
Software under Section 2.1 of this License shall 
terminate. 
3. In the event of termination under Sections 
5.1 or 5.2 above, all end user license agreements 
(excluding distributors and resellers) which have 
been validly granted by You or Your distributors 
under this License prior to termination shall 
survive termination. 
6. Disclaimer of Warranty 
Covered Software is provided under this License 
on an “as is” basis, without warranty of any kind, 
either expressed, implied, or statutory, including, 
without limitation, warranties that the Covered 
Software is free of defects, merchantable, fit for 
a particular purpose or non-infringing. The entire 
risk as to the quality and performance of the 
Covered Software is with You. Should any 
Covered Software prove defective in any respect, 
You (not any Contributor) assume the cost of any 
necessary servicing, repair, or correction. This 
disclaimer of warranty constitutes an essential 
part of this License. No use of any Covered 
Software is authorized under this License except 
under this disclaimer. 
7. Limitation of Liability 
Under no circumstances and under no legal 
theory, whether tort (including negligence), 
contract, or otherwise, shall any Contributor, or 
anyone who distributes Covered Software as 
permitted above, be liable to You for any direct, 



   

indirect, special, incidental, or consequential damages of any 
character including, without limitation, damages for lost profits, 
loss of goodwill, work stoppage, computer failure or malfunction, 
or any and all other commercial damages or losses, even if such 
party shall have been informed of the possibility of such damages. 
This limitation of liability shall not apply to liability for death or 
personal injury resulting from such party’s negligence to the 
extent applicable law prohibits such limitation. Some jurisdictions 
do not allow the exclusion or limitation of incidental or 
consequential damages, so this exclusion and limitation may not 
apply to You. 
8. Litigation 
Any litigation relating to this License may be brought only in the 
courts of a jurisdiction where the defendant maintains its principal 
place of business and such litigation shall be governed by laws of 
that jurisdiction, without reference to its conflict-of-law 
provisions. Nothing in this Section shall prevent a party’s ability 
to bring cross-claims or counter-claims. 
9. Miscellaneous 
This License represents the complete agreement concerning the 
subject matter hereof. If any provision of this License is held to be 
unenforceable, such provision shall be reformed only to the extent 
necessary to make it enforceable. Any law or regulation which 
provides that the language of a contract shall be construed against 
the drafter shall not be used to construe this License against a 
Contributor. 
10. Versions of the License 
1. New Versions 
Mozilla Foundation is the license steward. Except as provided in 
Section 10.3, no one other than the license steward has the right to 
modify or publish new versions of this License. Each version will 
be given a distinguishing version number. 
2. Effect of New Versions 
You may distribute the Covered Software under the terms of the 
version of the License under which You originally received the 
Covered Software, or under the terms of any subsequent version 
published by the license steward. 
3. Modified Versions 
If you create software not governed by this License, and you want 
to create a new license for such software, you may create and use 
a modified version of this License if you rename the license and 
remove any references to the name of the license steward (except 
to note that such modified license differs from this License). 
4. Distributing Source Code Form that is Incompatible With 
Secondary Licenses 
If You choose to distribute Source Code Form that is 
Incompatible With Secondary Licenses under the terms of this 

version of the License, the notice described in 
Exhibit B of this License must be attached. 
Exhibit A - Source Code Form License Notice 
This Source Code Form is subject to the terms of 
the Mozilla Public License, v. 2.0. If a copy of 
the MPL was not distributed with this file, You 
can obtain one at http://mozilla.org/MPL/2.0/. 
If it is not possible or desirable to put the notice 
in a particular file, then You may include the 
notice in a location (such as a LICENSE file in a 
relevant directory) where a recipient would be 
likely to look for such a notice. 
You may add additional accurate notices of 
copyright ownership. 
Exhibit B - “Incompatible With Secondary 
Licenses” Notice 
This Source Code Form is “Incompatible With 
Secondary Licenses”, as defined by the Mozilla 
Public License, v. 2.0. 
Component: zlib 
Licensor: Jean-loup Gailly and Mark Adler  
 
Website: http://www.zlib.net/  
License: Copyright (C) 1995-2013 Jean-loup 
Gailly and Mark Adler 
 
zlib.h -- interface of the 'zlib' general purpose 
compression library version 1.2.8, April 28th, 
2013 
 
Copyright (C) 1995-2013 Jean-loup Gailly and 
Mark Adler 
 
This software is provided 'as-is', without any 
express or implied warranty.  In no event will the 
authors be held liable for any damages arising 
from the use of this software. 
 
Permission is granted to anyone to use this 
software for any purpose, including commercial 
applications, and to alter it and redistribute it 
freely, subject to the following restrictions: 
1. The origin of this software must not be 
misrepresented; you must not claim that you 
wrote the original software. If you use this 
software in a product, an acknowledgment in the 
product documentation would be appreciated but 
is not required. 



   

2. Altered source versions must be plainly marked as such, and 
must not be misrepresented as being the original software. 
3. This notice may not be removed or altered from any source 
distribution. 
 
Jean-loup Gailly Mark Adler 
jloup@gzip.org madler@alumni.caltech.edu  
 
Component: STLPort 
Licensor: Boris Fomitchev 
WebSite: http://www.stlport.org/  
License Agreement 
Boris Fomitchev grants Licensee a non-exclusive, non-
transferable, royalty-free license to use STLportand its 
documentation without fee. 
By downloading, using, or copying STLport or any portion 
thereof,  Licensee agrees to abide by the intellectual property laws 
and all other applicable laws of the United States of America, and 
to all of the terms and conditions of this Agreement. 
Licensee shall maintain the following copyright and permission  
notices on STLport sources and its documentation unchanged : 
Copyright 1999,2000 Boris Fomitchev 
This material is provided "as is", with absolutely no warranty 
expressed or implied. Any use is at your own risk. 
Permission to use or copy this software for any purpose is hereby 
granted without fee, provided the above notices are retained on all 
copies. Permission to modify the code and to distribute modified 
code is granted, provided the above notices are retained, and a 
notice that the code was modified is included with the above 
copyright notice. 
The Licensee may distribute binaries compiled with STLport 
(whether original or modified) without any royalties or 
restrictions. 
The Licensee may distribute original or modified STLport 
sources, provided that: 
• The conditions indicated in the above permission notice are 
met; 
• The following copyright notices are retained when present, 
and conditions provided in accompanying permission notices are 
met : 
Copyright 1994 Hewlett-Packard Company 
Copyright 1996,97 Silicon Graphics Computer Systems, Inc. 
Copyright 1997 Moscow Center for SPARC Technology. 
Permission to use, copy, modify, distribute and sell this software 
and its documentation for any purpose is hereby granted without 
fee, provided that the above copyright notice appear in all copies 
and that both that copyright notice and this permission notice 
appear in supporting documentation. Hewlett-Packard Company 

makes no representations about the suitability of 
this software for any purpose. It is provided "as 
is" without express or implied warranty. 
Permission to use, copy, modify, distribute and 
sell this software and its documentation for any 
purpose is hereby granted without fee, provided 
that the above copyright notice appear in all 
copies and that both that copyright notice and 
this permission notice appear in supporting 
documentation. Silicon Graphics makes no 
representations about the suitability of this 
software for any purpose. It is provided "as is" 
without express or implied warranty. 
Permission to use, copy, modify, distribute and 
sell this software and its documentation for any 
purpose is hereby granted without fee, provided 
that the above copyright notice appear in all 
copies and that both that copyright notice and 
this permission notice appear in supporting 
documentation. Moscow Center for SPARC 
Technology  makes no representations about the 
suitability of this software for any purpose. It is 
provided "as is" without express or implied 
warranty. 
 
Flexler 1.18 
Copyright (c) 1993 The Regents of the 
University of California. 
All rights reserved. 
This code is derived from software contributed to 
Berkeley by Kent Williams and Tom Epperly. 
Redistribution and use in source and binary 
forms are permitted provided that: (1) source 
distributions retain this entire copyright notice 
and comment, and (2) distributions including 
binaries display the following acknowledgement:  
``This product includes software developed by 
the University of California, Berkeley and its 
contributors'' in the documentation or other 
materials provided with the distribution and in all 
advertising materials mentioning features or use 
of this software. Neither the name of the 
University nor the names of its contributors may 
be used to endorse or promote products derived 
from this software without specific prior written 
permission. 
 



   

THIS SOFTWARE IS PROVIDED ``AS IS'' AND WITHOUT 
ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE. 
 



   

Typographic Conventions 
 

Type Style  Description 

Example Text Words or characters quoted from 
the screen. These include field 
names, screen titles, 
pushbuttons labels, menu 
names, menu paths, and menu 
options. 

Cross-references to other 
documentation 

Example text Emphasized words or phrases in 
body text, graphic titles, and 
table titles 

EXAMPLE TEXT Technical names of system 
objects. These include report 
names, program names, 
transaction codes, table names, 
and key concepts of a 
programming language when 
they are surrounded by body 
text, for example, SELECT and 
INCLUDE. 

Example text Output on the screen. This 
includes file and directory names 
and their paths, messages, 
names of variables and 
parameters, source text, and 
names of installation, upgrade 
and database tools. 

Example text Exact user entry. These are 
words or characters that you 
enter in the system exactly as 
they appear in the 
documentation. 

<Example text> Variable user entry. Angle 
brackets indicate that you 
replace these words and 
characters with appropriate 
entries to make entries in the 
system. 

EXAMPLE TEXT Keys on the keyboard, for 
example, F2 or ENTER. 

Icons 
 

Icon Meaning 

 Caution 

 Example 

 Note 

 Recommendation 

 Syntax 

 

Additional icons are used in 
SAP Library documentation to 
help you identify different types 
of information at a glance. For 
more information, see Help on 
Help → General Information 
Classes and Information 
Classes for Business 
Information Warehouse on the 
first page of any version of SAP 
Library
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 Installing and Updating TREX – Single Host 
Purpose 
This guide describes the single-host installation and update of SAP NetWeaver Search and 
Classification (TREX). The target audience for the guide consists of system administrators 
and consultants. 

 
Restricted support of global file share functionality by TREX 7.1 installation 

TREX 7.0 offers the installation of a TREX central instance on a global file 
share. The global file share basically consists of the SAP system directory 
usr/sap/<sapsid>/sys. On this global file share you can store SAP profile 
files centrally, so that they can be accessed by other TREX dialog instances of a 
distributed landscape. You can use this functionality for setting up distributed 
TREX landscapes.  

By the TREX 7.1 installation the global file share functionality is currently only 
supported in a restricted manner. During the TREX 7.1 installation the customer 
can not specify the path to the global file share (SAP system directory 
usr/sap/<sapsid>/sys). The global file  share will be installed only once on 
the host, where TREX 7.1 will be initially installed and can not be placed on 
other hosts. So there still is a global file share for the TREX 7.1 installation, but it 
can not be placed independently from the initial TREX 7.1 installation on other 
hosts of your distributed landscape. TREX is developing the unrestricted global 
file share functionality for TREX 7.1 for the end of 2008. 

 

The guide is structured as follows: 

● The section Implementation Considerations [Page 4] explains what you need to take 
into account before the installation.  

● The section Naming Conventions [Page 10] contains information on special naming 
conventions used in this guide. 

● The section Checklists for the Installation [Page 11] contains a separate checklist for 
each installation variant, including an overview of the installation steps. 

● The section Installation Preparations [Page 21] describes what to do before the 
installation, especially how to download the TREX software package from SAP Service 
Marketplace. 

● The section Installation and Update [Page 27] describes the necessary TREX 
installation and update steps, installation screens, and input parameters. 

● The section TREX Basic Configuration [Page 34] describes the configuration steps you 
have to perform after the TREX installation. 

● The section Installation Check [Page 51] describes how to check whether the 
installation of the server software was successful. 

● The section Additional Information [Page 53] contains information on troubleshooting 
problems that might occur during the installation and explains how to control the 
installation from another host. It also describes how to start, stop, and uninstall TREX. 
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Constraints 
Additional Configuration Steps Depending on the Application 
Additional configuration steps may be necessary depending on the application for which you 
are installing TREX. These additional steps are not described in this guide. You can find them 
in the documentation on the application in question. 

 

 

 Implementation Considerations 
Refer to the following information before starting the installation. 

Master Guides 
If you are installing TREX as part of a mySAP Business Suite solution, a business scenario, 
or an IT scenario, familiarize yourself with the relevant master guide before beginning the 
installation. 

Master guides are the central documents for implementing mySAP Business Suite solutions, 
business scenarios, and IT scenarios. They list the components and third-party applications 
that are necessary for a business scenario or an IT scenario, and refer to any necessary 
installation and upgrade guides. They also define the installation sequence. 

 

 Integration of TREX and Applications That Use It 
TREX is based on a client/server architecture. The client software is integrated into the 
application that uses the TREX functions, and allows communication with the TREX servers. 
The TREX servers execute the requests of the clients: They index and classify documents 
and respond to search queries.  

TREX offers an ABAP and a Java client. This allows ABAP and Java applications to use 
TREX functions. ABAP and Java applications communicate with the TREX servers using 
different protocols and components. 

● ABAP applications communicate with TREX servers using the RFC protocol. 
Communication takes place using an instance of the SAP Gateway and an RFC 
server. 

For more information, see Connecting TREX with an ABAP Application (RFC 
Connection) [Page 44]. 

● Java applications communicate with TREX using the HTTP or HTTPS protocol. This 
communication takes place using a Web server that is enhanced with TREX-specific 
functions. 

For more information, see Connecting TREX with a Java Application (HTTP 
Connection) [Page 50]. 

RFC and Web servers have similar functions: They receive the requests of the application, 
convert them to a TREX-internal format, and send them on to the responsible TREX server. 

The graphic below depicts the interaction between applications and TREX. 
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There is no dependency between TREX and the application using TREX with 
regard to the operating system used. You can install TREX on a different 
operating system to the application that accesses TREX. 

 
Use all installable units within SAP NetWeaver that have the same support 
package level. Only by using the same support packages you can ensure the 
integration and smooth collaboration between all systems, stand-alone engines, 
and clients within SAP NetWeaver. 

Connecting TREX to More Than One Application 
In principle, you can connect one TREX system to more than one application.  

Note the following: 

● The TREX system must have appropriate dimensions so that it can process the load of 
all the applications. 

● You must take organizational measures to ensure that the applications use separate 
index namespaces. 

 

 SAP NetWeaver BI Accelerator 
SAP NetWeaver BI Accelerator: a Key Functionality for High-
Performance Analytics 
The BI accelerator is based on TREX technology. It is the aggregation engine for the 
accelerator functionality of SAP NetWeaver Business Intelligence (BI), a key functionality for 
high-performance analytics, which belongs to the Enterprise Data Warehousing IT scenario. 

For more information see the SAP Net Weaver Master Guide on SAP Service Marketplace 
service.sap.com/instguides. 

A TREX aggregation engine for processing structured business data powers this functionality. 
The data of the BI InfoCubes is replicated to the TREX engine and stored as TREX indexes. 
BI accelerator benefits companies that handle large volumes of data. The average response 
time is significantly improved in comparison with traditional approaches. 

The following graphic depicts the relationship between the BI accelerator and the BI System: 
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How To Use, Install, and Update the BI Accelerator  
● Use only with BI 

The BI accelerator is based on TREX technology. For the BI accelerator, you require 
an installation based on a 64-Bit architecture. The hardware partners deliver this 
variant in preconfigured form as the BI accelerator box. You must note that a TREX 
installation configured for searching metadata and documents based on a 32-Bit 
architecture cannot be used for the BI accelerator. In turn, you cannot use a BI 
accelerator box to search metadata and documents. In order to use both the search 
functions and the BI accelerator, you require two separate installations.  

 
You cannot use the BI accelerator for the regular TREX search and 
classification functions. 

In order to use the preinstalled BI Accelerator Box, you must enter the fixed RFC 
destination defined for this purpose (default: TREX_HPA) in table RSADMINA. 

● Installation on preconfigured hardware 

The BI accelerator is a special LINUX 64-Bit version of SAP NetWeaver Search and 
Classification (TREX), which is delivered on preconfigured hardware. All installation 
and configuration steps will be done during the preconfiguration of the hardware by the 
hardware vendor. 

● Download update from SAP Service Marketplace 

BI customers have to update and patch the BI accelerator. They can download the 
updates and patches for the BI accelerator from the SAP Service Marketplace 
service.sap.com/swdc  → Download → Support Packages and Patches → Entry 
by Application Group  → SAP NetWeaver  → SAP NETWEAVER → SAP 
NETWEAVER 7.0 → SAP BI Accelerator  → SAP BI Acelerator 7.0  → TREX 7.10  → 
Linux on x86 64 64bit  

 
For more information about the BI accelerator, see the following SAP notes: 

■ 883726 Central Note BI accelerator 

■ 875400 Installing SAP NetWeaver BI accelerator 

■ 883725 Updating SAP NetWeaver BI accelerator 

■ 902533 HowToGuide Connecting/Operating BI Accelerator Box 

■ 984034 BI Accelerator High Availability 
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See also the SAP NetWeaver Developers Network (SDN) for detailed 
information about the BI accelerator https://www.sdn.sap.com/irj/sdn/bia. 

BI accelerator: Preconfigured Blade System 
The BI accelerator is installed on a preconfigured blade system. A blade system consists of 
hosts in the form of server blades. The server blades are connected to centralized disk 
storage. This is referred to here as a file server, regardless of the underlying hardware. 

The special feature of a TREX installation on a blade system is that both the TREX software 
and the TREX data can be stored centrally. This means that the software is installed only 
once on the file server. Maintaining the system is efficient because you have to implement 
software updates once only. 

All server blades on which TREX is running access the same program files. However, each 
server blade has its own configuration files. The configuration files in the directory 
<TREX_DIR> are only used as templates. A script creates a separate subdirectory for each 
server blade and copies the configuration files to this subdirectory. The graphic below depicts 
how data, programs, and configuration files might be stored in a BI accelerator blade system. 
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 Minimal and Distributed TREX Systems 
Minimal TREX System (Single-Host Installation) 
A minimal system consists of one TREX instance (one installation of the server software). 
You can use a minimal system as a demo, test, and production system.  

https://www.sdn.sap.com/irj/sdn/bia
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For a production system, SAP recommends that you install the server software 
on a single host that is used exclusively for TREX. 

 
If TREX is running on the same host as other components, you must make sure 
of the following: 

■ There is enough main memory for all components. 

■ TREX can use the required main memory space exclusively. 

Sizing 
The required hardware for the server software depends on the following factors: 

● How many documents of what type are to be indexed? 

● What quantities of documents are to be indexed initially, and what quantities during 
routine operation? 

● How many search queries are expected? How many parallel search queries are 
expected? 

Plan the required number of hosts and the equipping thereof with your SAP hardware partner. 
Use the information in Hardware,Software and Network  Requirements [Page 17] as a basis 
for this. 

Distributed TREX System (Multiple Host Installation) 
Search and Classification (TREX) consists of a client component and a server component. 
The server component is based on a flexible architecture that allows a distributed installation. 
You can use a distributed installation to achieve the following: 

● Load balancing 

You can distribute the search and indexing load among several hosts. 

● High availability 

You can make sure that both indexing and searching are highly available. 

 
Your TREX system can quickly reach its performance limit if you install TREX on 
a single server in a productive scenario with large document sets and a large 
number of search queries. SAP therefore recommends that you calculate the 
expected load and availability requirements for your TREX system early on in 
the planning process and start with a distributed TREX installation immediately if 
that is what you require. 

 
In a distributed scenario, the same TREX version and patch level must run on all 
TREX hosts. Mixed installations with different TREX versions are not supported. 

 
For more information on installing and configuring a distributed TREX system, 
see the SAP NetWeaver Distributed Search and Classification (TREX) Systems 
Installation Guide on the SAP Service Marketplace at 
service.sap.com/instguides. 
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 Installation and Configuration of Server and Client 
Software 
Installation and Configuration of the Server Software 
The TREX servers can be used by one or more applications. When you are installing TREX, 
you need to know the type of application and communication protocol. There are the following 
possibilities: 

● The TREX servers are only used by Java applications. 

Since Java applications communicate with the TREX servers using HTTP, you 
definitely need to carry out the installation and configuration steps that enable an HTTP 
connection. 

For more information, see Connecting TREX with a Java Application (HTTP 
Connection) [Page 50]. 

● The TREX servers are only used by ABAP applications. 

Since ABAP applications communicate with the TREX servers using RFC, you 
definitely need to carry out the installation and configuration steps that enable an RFC 
connection. 

For more information, see Connecting TREX with an ABAP Application (RFC 
Connection) [Page 44]. 

● The TREX servers are used by Java and ABAP applications. 

In this case, execute the installation and configuration steps necessary for an HTTP 
and an RFC connection.  

For more information, see Connecting TREX with a Java Application (HTTP 
Connection) [Page 50] and Connecting TREX with an ABAP Application (RFC 
Connection) [Page 44]. 

 
The documents to be indexed are sent by an ABAP application to TREX. The 
search takes place using a Web application (Java application).  

This guide contains a checklist with an overview of necessary installation and configuration 
steps for each case. 

Installation and Configuration of the Client Software 
● ABAP client 

The ABAP client is part of the SAP system, and must not be installed separately. The 
necessary configuration is described in this guide. 

For more information, see Connecting TREX with an ABAP Application (RFC 
Connection) [Page 44]. 

● Java client 

As a TREX service, the Java client is part of the JEE engine of the SAP NetWeaver 
Application Server and does not have to be installed separately. The necessary 
configuration is described in this guide. 

For more information, see Connecting TREX with a Java Application (HTTP 
Connection) [Page 50]. 
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 Naming Conventions 
The following naming conventions are valid for this documentation: 

Terminology 

Term Meaning 

TREX host Host on which the TREX server software is installed 

TREX instance One installation of the TREX server software 

 

Variables 

Variable Meaning 
<SAPSID> System ID in uppercase letters 
<sapsid> System ID in lowercase letters 
<TREX_DIR> Installation directory for TREX. The path to the directory is: 

● On UNIX  
/usr/sap/<sapsid>/trx<instance_number> 

● On Windows 
<disk_drive>:\usr\sap\<SAPSID>\TRX<instance_num
ber> 

<TREX_DOWNLOAD> Directory for storing the downloaded TREX software package 
from SAP Service Marketplace 

<SAP_System_Directory> SAP system directory: 

● On UNIX /<sapmnt>/<sapsid>/SYS 

● On Windows <disk_drive>:\usr\sap\<SAPSID>\SYS 
<OS> Name of the operating system in a path. 

User <sapsid>adm Operating system user that you log on with to administrate 
TREX. 

User 
SAPService<SAPSID> 

Operating system user under which the TREX processes run. 

User 
<j2eeadm> 

Operating system user that you use to log on to the host on 
which the J2EE Engine is running. 

The following example shows how variables are used. 

 
Go to the directory /usr/sap/<sapsid>/trx<instance_number>.  

If the SAP system ID is KB1 and the instance number is 01, you have to go to 
the directory /usr/sap/KB1/trx01. 

Path specifications 
The forward slash (/) is usually used in path specifications such as 
<TREX_DIR>/<host_name>/sapprofile.ini. 

Commands 
Commands such as script calls are sometimes distributed over several lines in this 
documentation. When you execute the commands, enter them in one line. 
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 Checklists for the Installation 
Purpose 
Use the tables below as checklists for the installation of the system. All necessary installation 
phases (planning, preparation, installation, and post-installation activities) are listed in these 
tables. 

Use the links to the general descriptions of actions and to additional information that will help 
you when executing the actions. By doing this, you ensure that you do not overlook any 
important information. 

Process Flow 
... 

1. Print the relevant checklists: 

○ Installation with HTTP Connection [Page 11] 

○ Installation with RFC Connection [Page 13] 

○ Installation with HTTP and RFC Connections [Page 14] 

2. Carry out the installation steps in the order specified in the tables. 

○ When carrying out an obligatory step during the installation, follow the link to the 
relevant section. 

○ Then carry out the work steps described there. 

○ When the installation step has been successfully completed, place a check ( ) 
next to the relevant entry in the table in order to record your progress. 

○ Then continue with the next step listed in the table. 

 

 

 Installation with an HTTP Connection 
Server Side 
Installation Planning 
!  Activity 

 Check the Hardware, Software and Network Requirements [Page 17]. 

 Check which documentation [Page 20] you need for the installation. 

 

Installation Preparations 
!  Activity 

 If you want to install multiple TREX instances, read the information [Page 25] on 
this. 

 Download the TREX binaries [Page 21]. 

 Windows: Ensure the required authorization for  running the installer [Page 25]. 
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 Check whether there is sufficient disk space [Page 26] for installing the TREX 
software. 

 

Installation 
!  Activity 

 Install TREX with a Virtual Host Name [Page 30] 

To make your TREX installation accessible using a virtual host name you change 
the host name of the host on which you intend to install TREX.  

 Install TREX using shell scripts [Page 28]. 

 

Post-Installation Configuration 
!  Activity 

 Start the TREX Admin Tool [Page 54] 

You need the TREX admin tool (stand-alone) for post-installation configuration 
steps. As of TREX 7.1 the TREX admin tool runs independently of the TREX 
servers and services. 

 TREX starts automatically if you restart the host.  

If you have not restarted the host, start TREX manually (see Starting and Stopping 
TREX on UNIX [Page 60]). 

 HTTP communication 

 Configure the TREX Web Server [Page 36] 

Java applications communicate with the TREX servers using HTTP/HTTPS by 
means of the TREX Web server. After installing TREX, you have to configure the 
TREX Web server so that your Java application can access TREX. 

 Configure TREX Proxy Settings [Page 36] 

If there is a proxy server between the TREX servers and the documents to be 
indexed, specify the proxy server and define exclusion rules if necessary. 

 TREX Languages 

 Select Languages for TREX Language Recognition [Page 39] 

TREX supports the indexing and analysis of documents in different languages. You 
select languages to be identified by TREX language recognition. 

 System Landscape Directory 

 Configure TREX for the System Landscape Directory (SLD) [Page 39] 

 General Windows Configuration 

 Check Performance Settings for the Operating System (Windows) [Page 42] 

On Windows no further actions are needed to start TREX. The SAP service for the 
corresponding TREX instance is registered as a Windows service and starts 
automatically after installation. 

 

Client Side 
Configuration 
!  Activity 
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 Connecting TREX with a HTTP Application 
 Specify the Address of the TREX Name Server [Page 49] 

Enter the address of the TREX name server in the Java client configuration settings 
(TREX service in the NetWeaver Administrator of the JEE). 

 Check Proxy Settings [Page 37] 

If an application is unable to communicate with TREX, it may be due to the 
application trying to access TREX through a proxy server. 

 Wizard-Based Configuration 

 Wizard-Based Basic Configuration for TREX [Page 33] 

The configuration wizard enables automatic configuration of the settings that are 
required for the application using TREX to communicate with TREX using an HTTP 
or RFC connection. 

 

 Installation with an RFC Connection 
Server Side 
Installation Planning 
!  Activity 

 Check the Hardware, Software and Network Requirements [Page 17]. 

 Check what documentation [Page 20] you need for the installation. 

 

Installation Preparations 
!  Activity 

 If you want to install multiple TREX instances, read the information [Page 25] on 
this. 

 Download the TREX software [Page 21]. 

 Windows: Ensure the required authorization for  running the installer [Page 25]. 

 Check whether there is sufficient disk space [Page 26] for installing the TREX 
software. 

 

Installation 
!  Activity 

 Install TREX with a Virtual Host Name [Page 30] 

To make your TREX installation accessible using a virtual host name you change 
the host name of the host on which you intend to install TREX.  

  Install TREX using shell scripts [Page 28].  

 

Post-Installation Activities 
!  Activity 

 Start the TREX Admin Tool [Page 54] 
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You need the TREX admin tool (stand-alone) for post-installation configuration 
steps. As of TREX 7.1 the TREX admin tool runs independently of the TREX 
servers and services. 

 TREX starts automatically if you restart the host.  

If you have not restarted the host, start TREX manually (see Starting and Stopping 
TREX on UNIX [Page 60]). 

 TREX Languages 

 Select Languages for TREX Language Recognition [Page 39] 

TREX supports the indexing and analysis of documents in different languages. You 
select languages to be identified by TREX language recognition. 

 System Landscape Directory 

 Configure TREX for the System Landscape Directory (SLD) [Page 39] 

 General Windows Configuration 

 Check Performance Settings for the Operating System (Windows) [Page 41] 

On Windows no further actions are needed to start TREX. The SAP service for the 
corresponding TREX instance is registered as a Windows service and starts 
automatically after installation. 

 Connecting TREX with an ABAP Application 
(Configuration of the RFC Connection) 

 Create a SAP System User for the TREX Admin Tool (Stand-Alone) [Page 45] 

You must create an SAP user that the TREX admin tool (stand-alone) can use to 
log on to the SAP system. 

 Determine the SAP System Connection Information [Page 46] 

The TREX admin tool requires connection information for the SAP system. You 
determine the information and specify it in the TREX admin tool. 

 Configure the RFC Connection in the TREX Admin Tool [Page 47]. 

 Wizard-Based Configuration 

 Wizard-Based Basic Configuration for TREX [Page 33] 

The configuration wizard enables automatic configuration of the settings that are 
required for the application using TREX to communicate with TREX using an HTTP 
or RFC connection. 

 

Client Side 
Configuration 
!  Activity 

 On the client side, no further configuration steps are required. 

 

 Installation with HTTP and RFC Connections 
Server Side 
Installation Planning 
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!  Activity 

 Check the Hardware, Software and Network Requirements [Page 17]. 

 Check which documentation [Page 20] you need for the installation. 

 

Installation Preparations 
!  Activity 

 If you want to install multiple TREX instances, read the information [Page 25] on 
this. 

 Download the TREX binaries [Page 21]. 

 Windows: Ensure the required authorization for running the installer [Page 25]. 

 Check whether there is sufficient disk space [Page 26] for installing the TREX 
software. 

 

Installation 
!  Activity 

 Install TREX with a Virtual Host Name [Page 30] 

To make your TREX installation accessible using a virtual host name you change 
the host name of the host on which you intend to install TREX. You do this before 
you start the TREX installation. 

 Install TREX using shell scripts [Page 28]. 

 

Post-Installation Configuration 
!  Activity 

 Start the TREX Admin Tool [Page 54] 

You need the TREX admin tool (stand-alone) for post-installation configuration 
steps. As of TREX 7.1 the TREX admin tool runs independently of the TREX 
servers and services. 

 TREX starts automatically if you restart the host.  

If you have not restarted the host, start TREX manually (see Starting and Stopping 
TREX on UNIX [Page 60]). 

 HTTP communication 

 Configure the TREX Web Server [Page 36] 

Java applications communicate with the TREX servers using HTTP/HTTPS by 
means of the TREX Web server. After installing TREX, you have to configure the 
TREX Web server so that your Java application can access TREX. 

 Configure TREX Proxy Settings [Page 36] 

If there is a proxy server between the TREX servers and the documents to be 
indexed, specify the proxy server and define exclusion rules if necessary. 

 TREX Languages 

 Select Languages for TREX Language Recognition [Page 39] 

TREX supports the indexing and analysis of documents in different languages. You 
select languages to be identified by TREX language recognition. 
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 System Landscape Directory 

 Configure TREX for the System Landscape Directory (SLD) [Page 39] 

 TREX starts automatically if you have restarted the host.  

If you have not restarted the host, start TREX manually. 

(See Starting and Stopping TREX on UNIX [Page 60].) 

 General Windows Configuration 

 Check Performance Settings for the Operating System (Windows) [Page 42] 

On Windows no further actions are needed to start TREX. The SAP service for the 
corresponding TREX instance is registered as a Windows service and starts 
automatically after installation. 

 Connecting TREX with an ABAP Application 
(Configuration of the RFC Connection) 

 Create a SAP System User for the TREX Admin Tool (Stand-Alone) [Page 45] 

You must create an SAP user that the TREX admin tool (stand-alone) can use to 
log on to the SAP system. 

 Determine the SAP System Connection Information [Page 46] 

The TREX admin tool requires connection information for the SAP system. You 
determine the information and specify it in the TREX admin tool. 

 Configure the RFC Connection in the TREX Admin Tool [Page 47]. 

 Wizard-Based Configuration 

 Wizard-Based Basic Configuration for TREX [Page 33] 

The configuration wizard enables automatic configuration of the settings that are 
required for the application using TREX to communicate with TREX using an HTTP 
or RFC connection. 

 

Client Side – Java Application 
Installation and Configuration 
!  Activity 
 Connecting TREX with a HTTP Application 
 Specify the Address of the TREX Name Server [Page 49] 

Enter the address of the TREX name server in the Java client configuration settings 
(TREX service in NetWeaver Administrator of the JEE). 

 Check Proxy Settings [Page 37] 

If an application is unable to communicate with TREX, it may be due to the 
application trying to access TREX using a proxy server. 

 

Client Side – ABAP Application 
Configuration 
!  Activity 

 On the client side, no further configuration steps are required. 

 



Search and Classification TREX                                                                           Januar  2022 

 

Installing and Updating TREX – Single Host  17 

 

 Installation Planning 
Purpose 
The following sections contain information that is relevant when planning the installation. 

 

 Hardware, Software and Network Requirements 
The tables below contain the hardware and software requirements for the TREX server 
software.  

 
The requirements for hardware and software listed here are valid for a TREX 
installation on a single host (single-server system). The requirements for a 
distributed system that supports load balancing and high availability are listed in 
the guide for the installation and configuration of a distributed TREX system. 
You can find the Installation Guide – SAP NetWeaver TREX Multiple Hosts on 
the SAP Service Marketplace at service.sap.com/instguides. 

Hardware Requirements 

Requirement Type Requirement 

Hard disk capacity: ● Installer work directory 

You require the following for the installation software: 

○ On UNIX, 500 MB in temporary directories or in a 
directory of your choice. 

○ On Windows, 500 MB in the directory C:\Program 
Files 

● SAP system directory 
... 

○ On UNIX, at least 1 GB in the directory 
/<sapmnt>/<sapsid>/SYS. 

○ On Windows, at least 1 GB in the directory 
<disk_drive>:\usr\sap\<SAPSID>\SYS. 

● TREX directory 

You need the following for the TREX software: 

○ On UNIX, at least 1 GB in the directory 

/usr/sap/<sapsid>/trx<instance_number>. 

○ On Windows, at least 1 GB in the directory 
<disk_drive>:\usr\sap\<SAPSID>\ 
TRX<instance_number> 

You also need disk space in this directory for the trace files 
that TREX writes during routine operation 

● Index directory 

A minimum of 80 GB, depending on the number and type of 
documents to be indexed. 

If documents exist in different formats (Microsoft Word, PDF, 
and so on), the index needs approximately half as much disk 
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Requirement Type Requirement 
space as the documents. For pure HTML documents, the 
index needs about twice as much disk space as the 
documents. In addition, the same amount of disk space as for 
the index is needed temporarily for the optimization process. 

 
A document set that consists only of HTML documents 
and has a total size of 10 GB generates an index size 
of 20 GB (2 x 10GB). An additional 20 GB disk space 
is needed temporarily for optimization. Therefore, you 
need 40 GB disk space altogether: 20 GB permanently 
and 20 GB temporarily. 

● Queue directory 

The queues require approximately three quarters of the disk 
space required by the indexes. The documents to be indexed 
are kept temporarily in the queue directory before being 
forwarded to actually be indexed. 

In the case of an installation with an RFC connection, you 
can use TREX with or without a queue server. If you are not 
using a queue server, the queue directory is not relevant. 
SAP Note 658052 contains information on which 
configuration is suitable for which application.  

The three directories can be located on different partitions. The 
index directory and queue directory can also be located on a file 
server. The TREX host must be able to access the file server as 
quickly as it can access the local hard drive.  

RAM ● Demo or test system: At least 8 GB 

● Production system: 64 GB, at least 4 GB per CPU 

With two index servers per TREX instance: At least 4 CPUs 

 
The amount of main memory that is actually used 
depends on several factors. For example, in the case 
of the index server, influencing factors are index size, 
number of parallel search requests, and amount of the 
number of hits. 

 

Windows: Software Requirements 

Requirement Type Requirement 

Operating system TREX supports the following Windows version: 

Microsoft Windows Server 2012, 2016 and 2019 64BIT (US 
English version)  

 
For security reasons, the supported partition installed 
on Windows is NTFS (NT file system) not FAT32 (file 
allocation table). 
For the most up-to-date information about platform 
and operating system availability for TREX check the 
Platform Availability Matrix (PAM) on SAP Service 
Marketplace service.sap.com/pam. 
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Requirement Type Requirement 

Python Python 3.8. A Python version is part of the delivery. It is installed 
by the TREX setup program in the directory 
<TREX_DIR>\exe\Python. 

Web server Only relevant for an installation with an HTTP connection. 

Microsoft Internet Information Server (IIS)  

 
The TREX delivery does not contain the Internet 
Information Server (IIS), so you have to install an IIS  
on your TREX host before configuring the TREX Web 
server. You must ensure that the Internet Information 
Server (IIS) is installed. Also make sure that the IIS is 
running correctly. Activate the World Wide Web 
Publishing Service, IIS Admin Service, and HTTP 
SSL in the Windows Services tool. To do this 
navigate to Control Panel → Administrative Tools → 
Computer Management → Services and Application 
→ Internet Information Services (IIS) Manager. 

 

UNIX: Software Requirements 

Requirement Type Requirement 

Operating system TREX supports one of the following UNIX version: 

LINUX SUSE SLES12/15 X86_64 64BIT  
LINUX REDHAT EL7/EL8  
LINUX ORACLE OL7 

 
TREX only supports LINUX distributions that have 
been released by SAP.  

For the most up-to-date information about platform 
and operating system availability for TREX check the 
Platform Availability Matrix (PAM) on SAP Service 
Marketplace service.sap.com/pam. 

Python Python 3.8. A Python version by ActiveState is part of the delivery. 
It is installed by the TREX setup program in the directory 
<TREX_DIR>/exe/Python directory.  

Web server Only relevant for an installation with an HTTP connection. 

Apache Web Server 2.4: The Web server is part of the delivery, 
and is installed by the TREX setup program in the 
<TREX_DIR>/exe/Apache directory.  

 
Network Requirements 
 

Requirement Type Requirement 

Network configuration The host on which TREX is installed should have an isolated 
network subnet (different than the one which exposes the 
application to the outside network), which is shared only with the 
hosts on which the applications that are using TREX are installed 
on. No other hosts should have network connection to the TREX 
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Requirement Type Requirement 
host. 

 
 

 Required Documentation 
You require this installation guide and the following additional documentation for the 
installation: 

● SAP Notes on installation 

● Information available on SAP Service Market Place 

SAP Notes on Installation 
You must read the SAP Notes on installation before you begin the installation. The SAP 
Notes contain current installation information and corrections to the installation 
documentation. 

Make sure that you use the current version of the SAP Notes. The SAP Notes can be found 
on the SAP Service Marketplace at service.sap.com/notes.  

Relevant SAP Notes 

SAP Note 
Number 

Title Comments 

2460148 TREX 710:  supported platforms  
and OS software requirements 
and restrictions 

List of   supported platforms  and 
additional software requirements and 
restrictions 

1003900 TREX 7.1: Central note Contains information for all TREX 7.1 
installations 

2199947 TREX 7.10: Upgrade Apache Web 
Server to revision  

Contains information about  the most 
current version of Apache 

1007349 TREX 7.0/7.1: Linux Kernel 
Parameters 

Contains information about how to set 
file handles for Linux adequately 

845974  TREX WebServer (IIS) Application 
Pool disabled after recycle 

Contains information about TREX web 
server and IIS application pool 

1856942  Latest Revision for TREX 7.10 Contains information about latest 
available TREX revision 

Information Available in SAP Service Marketplace 
Information on the following areas is available in the SAP Service Marketplace. 

General Quick Links 

Description Internet Address Title 

SAP Notes service.sap.com/notes – 

Released platforms service.sap.com/platforms – 

System sizing  service.sap.com/sizing Quick Sizer tool 

Front-end installation  

 

service.sap.com/instguides Front End Installation 
Guide 
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Security service.sap.com/security – 

 

 Installation Preparations 
Purpose 
The following sections describe the steps you carry out before the TREX installation. 

 

 Downloading the TREX Binaries 
Use 
You download the most current TREX version from SAP Service Marketplace. You can use 
the downloaded TREX software package for the following purposes: 
... 

● Installing TREX with Shell Scripts [Page 29] 

● Updating TREX with Shell Scripts [Page 32] 

You use SAPCAR to extract the downloaded TREX software archives. 

 

Prerequisites 
Make sure the latest version of the SAPCAR archiving tool is available on each installation 
host. 

You require the SAPCAR archiving tool to be able to unpack software component archives 
(*.SAR files) which is the format of software life-cycle media and tools that you can download 
from the SAP software distribution center. 

If required, you can download the latest version of SAPCAR from: 
http://service.sap.com/swdc  Support Packages and Patches  A – Z Index  S  
SAPCAR. 

For more information about SAPCAR, see SAP Note 212876 

 

Procedure 
Download  the TREX Software Package 
... 

1. Access the SAP Software Distribution Center on SAP Service Marketplace at 
http://service.sap.com/swdc 

2. Navigate to SAP Software Download Center → Download → Support Packages and 
Patches → Browse our Download Catalog → SAP NetWeaver and complementary 
products  → SAP NetWeaver  → SAP NetWeaver <Release>  → Entry by Component 
→ Search and Classif. (TREX)  → TREX 7.10 → <operating_system> 
(Linux_on_X86_64_64bit/Windows Server_on_x64_64bit) → 
TREX71_<Revision>.SAR 

3. Download the TREX software package from the specified folder on SMP into a 
temporary folder on your host. 

Unpack the TREX Software Packages Using SAPCAR 
... 

http://service.sap.com/swdc
http://service.sap.com/swdc
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1. Create a directory <TREX_DOWNLOAD> for the TREX software package. 

2. Use SAPCAR to extract the downloaded TREX software archive 
TREX71_<REVISION>.SAR to the directory. 

 
SAPCAR is installed with each application server based on SAP NetWeaver in 
the kernel directory. If you do not have access to the currently installed SAPCAR 
tool, you can download the unpackaged version of the SAPCAR tool at 
http://service.sap.com/patches →  Entry by Application Group  → Additional 
Components → SAPCAR. 

... 

1. Go to the directory in which you have downloaded or copied the archive files: 

○ Linux: cd /<TREX_DOWNLOAD> 

○ Windows: cd \<TREX_DOWNLOAD> 

2. Start SAPCAR to extract the archive to the current directory: 

○ Linux: <path to SAPCAR>/sapcar –xvf <file_name>.SAR 

○ Windows: <path to SAPCAR.EXE>\sapcar.exe –xvf 
<file_name>.SAR 

 
You can use the option -R to specify a specific target directory, for instance, 
sapcar -xvf <SAR_file> -R <target_dir>. Directories in the archive 
are created as subdirectories of the target directory to retain the directory 
structure of the archive. 

 

 TREX System and TREX Instances 
Purpose 
The TREX server software comprises two parts: 

● Installation files for the TREX instance 

These are the TREX program files, configuration files, and so on. 

● Global file system 

This is a directory structure, in which information about the TREX system instances is 
stored. For example, this information is required by management tools to start the 
TREX system. 

The global file system must be highly available. All instances of a TREX system must 
have permanent access to it. The global file share basically consists of the SAP system 
directory usr/sap/<sapsid>/sys. 

 
By the TREX 7.1 installation the global file share functionality is currently only 
supported in a restricted manner. During the TREX 7.1 installation the customer 
can not specify the path to the global file share (SAP system directory 
usr/sap/<sapsid>/sys). The global file share will be installed only once on 
the host, where TREX 7.1 will be initially installed and can not be placed on 
other hosts. So there still is a global file share for the TREX 7.1 installation, but it 
can not be placed independently from the initial TREX 7.1 installation on other 
hosts of your distributed landscape. TREX is developing the unrestricted global 
file share functionality for TREX 7.1 for the end of 2008. 

http://service.sap.com/patches
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TREX Instance and SAP System Profile Directories 
During the installation of the TREX system, the following directories are important: 

● SAP system profile directory in the global file system: 

○ On UNIX /<SAP System Mount Directory>/<sapsid>/SYS/profile 

○ On Windows <SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile 

● Installation directory for the TREX instance: 

○ On UNIX /usr/sap/<sapsid>/trx<instance_number> 

○ On Windows 
<disk_drive>:\usr\sap\<SAPSID>\TRX<instance_number> 

Installation Procedure 
During the TREX installation, when you chose the installation option Install a TREX system, 
both a  TREX instances and a global file systems will be installed on your local host. Differing 
from the TREX 7.0 installation you can not decide where the global file system should be 
stored. 

 

TREX System 
A TREX system consists of the installation of a TREX instance together with a global file 
system on the a local host where you initially install TREX. Basic information about a TREX 
landscape is stored in the directory for the SAP system profiles. 

Directory structure and files 
On Windows the TREX installation creates a directory structure and SAP system profiles as 
shown in the graphic below: 

Folder Structure on TREX Single Host
(Global File System and TREX Instance)

...

profile\

usr\sap\<SAPSID>\

SYS\

TRX<instance_number>\

<trex_hostname>\

– DEFAULT.PFL
– <SAPSID>_TRX<instance_number>_<host>

exe\python_support\

...

TREX Instance/
<TREX_DIR>

queue\
index\

 Global File System / SAP System Directory

 SAP Profile Directory

 

Additional TREX Instance 
An additional TREX instance consists of a TREX instance without a global file system on the 
local host. In this case, the global file system together with the first TREX instance on the one 
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hand and the newly-installed TREX instance on the other hand form a unit from an 
administration perspective. This is visible in that they both have the same system ID 
(<SAPSID>) and use the same global file system. 

You install an additional TREX instance by means of a TREX script.  

For more information, see Installing an additional TREX Instance [Page 30] 

Directory structure and files 
On Windows the installation creates directory structures as illustrated in the graphic below: 

TREX Instance # 1

TRX<instance_number>\

...

usr\sap\<SAPSID>\First TREX Instance
and Global File System 

...

profile/

usr/sap/<SAPSID>/

SYS/

TRX<instance_number>/

<trex_hostname>/

exe/python_support/

usr\sap\<SAPSID>\

TREX Instance # 2

TRX<instance_number>\index/
queue/

<trex_hostname>/

exe/python_support/

index/
queue/

...

<trex_hostname>/

exe/python_support/

index/
queue/

 

Global File System (SAP System Directory) 
You have to ensure that the global file system (SAP system directory 
usr/sap/<sapsid>/sys) is highly available and accessible for all TREX instances at all 
times. 

Directory structure and files 
On Windows the installation creates directory structures as illustrated in the graphic below: 

Folder Structure on Global File system

...

profile/

usr/sap/<SAPSID>/

SYS/

– DEFAULT.PFL
– <SAPSID>_TRX<instance_number>_<host>
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SAP System Profiles for the Global File System 
During installation of a TREX system the central directory for the SAP system profiles will be 
created as part of the global file system (SAP system directory). In the SAP system profiles 
directory, the system automatically generates an instance profile for the TREX instances 
installed. System profiles contain information about the configuration of individual SAP 
instances. 

Depending on the entries made during installation, the system creates the following profiles: 

● System profile DEFAULT.PFL 

The system profile contains settings and information that are important throughout the 
system. The system profile exists once only in the global file system.  

● Instance profile <SAPSID>_TRX<instance_number>_<host> 

The instance profile contains specific information about the runtime environment for a 
TREX instance. 

 

 Information on Installing Multiple TREX Instances 
You can install several independent TREX instances on the same host. This is useful for test 
purposes. Note the following: 

During the setup 

● Give each instance a different instance number. 

● Each instance must be installed in its own directory. The TREX setup program ensures 
this by including the instance number in the directory name. 

● Each instance must use a different port. The TREX setup program suggests suitable 
ports so that they do not clash with other TREX instances on the same host. 

After the installation (HTTP connection) 
If you are installing TREX on Windows, you must make sure that the Web pages of the 
individual instances run independently of one another. The following configuration is required 
for this: 

● Microsoft IIS : There must be a separate Web service extension for each instance. 
Each TREX Web site must also use its own application pool. 

The configuration steps are described in this guide. 

 

 

 Windows: Required User Authorization for 
Running the Installer 
Use 
Although the installer automatically grants the required rights to the user account used for the 
installation, you have to check whether this account has the required authorization to perform 
the installation. The authorization required depends on whether you intend to perform a 
domain or local installation. If necessary, you have to ask the system administrator to grant 
the account the necessary authorization before you start the installation. If you attempt the 
installation with an account that has not the required authorization, the installation aborts. 
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This section informs you about the authorization required for a domain and a local installation. 

 
Do not use the user <sapsid>adm for running the installer. 

Domain Installation 
For a domain installation the account used for the installation needs to be a member of the 
local Administrators and the domain Admins group of the domain involved. All machines in 
the system must belong to the same domain. In a domain installation, the user information is 
stored centrally on the domain controller and can be accessed by all hosts in the system. 

If the SAP system is to be distributed across more than one machine, SAP strongly 
recommends you to perform a domain installation to avoid authorization problems. 

 

 
• If you install a system distributed over several hosts as a local installation, this can 

lead to authorization problems for the operating system users <sapsid>adm and 
SAPService<SAPSID>. It can also lead to problems with the transport directory, 
which is usually shared by several SAP systems. Therefore, SAP does not support a 
local installation for a system distributed over several hosts and recommends you to 
install a system distributed over several hosts as a domain installation. 

If you still want to perform a local installation for a system distributed over several 
hosts, make sure that: 

o You use the same password for the <sapsid>adm or the 
SAPService<SAPSID> user on all hosts. 
The password for the <sapsid>adm and SAPService<SAPSID> user can 
differ. 

o You use the same master password on all hosts. 

o All hosts belong to the same Windows work group. 

• In a Microsoft failover cluster configuration, you always have to perform a domain 
installation. 

• For performance and security reasons, SAP does not support an SAP system 
installation on a domain controller. 

• If for any reason, the account used for the installation is not a member of the domain 
Admins group, you can perform the installation with a domain user who is a member 
of the local Administrators group. However, the domain administrator has to prepare 
the system appropriately for you. 

For a domain installation, you need to: 

1. Check that the account used for the installation is a member of the domain Admins 
group. 

2. If required, obtain these rights by asking the system administrator to enter the 
account as a member of the domain Admins group. 

 

 Checking Disk Space 
Use 
The installer creates the installation directory for the TREX software in the following directory: 
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● Windows – <disk_drive>:\usr\sap\<SAPSID> 

● UNIX – /usr/sap/<sapsid> 

Before the installation starts, make sure that there is enough disk space in this directory for 
the TREX software. For information on the required disk space, see Hardware and Software 
Requirements [Page 17]. 

Procedure on UNIX 
Starting Point Procedure 

The directory /usr 
does not yet exist. 

For the directory /usr, select a partition that has sufficient disk 
space for the TREX software and other SAP software if necessary. 

The directory /usr 
exists, but the 
directory /usr/sap 
does not. 

Choose one of the following options: 

● Create a new partition with sufficient disk space for the 
directory sap. Insert the directory sap into the directory 
/usr. 

● Create the directory sap in a file system that has sufficient 
disk space. Generate a symbolic link to the directory sap in 
the directory /usr. 

The directory 
/usr/sap already 
exists. 

Go to the directory /usr/sap and check the amount of free disk 
space by executing the following command. 
df –k . 

If there is not enough disk space, proceed as follows: 
... 

1. Create the installation directory in a file system that has 
sufficient disk space. You must assign the installation directory 
the name trx<instance_number>. <instance_number> must 
match the instance number that you specified during the 
installation. 

2. Generate a symbolic link to the installation directory in the 
directory /usr/sap. 

 

Procedure on Windows 
On Windows you can choose the target drive during the installation. Use the Windows 
Explorer to check whether there is sufficient disk space on the target drive. 

 Installation 
Purpose 
You can install TREX in one of the following ways: 

• By running shell scripts [Page 29]. 

 

 

 

 

 

 



Search and Classification TREX                                                                           Januar  2022 

 

Installing and Updating TREX – Single Host  28 

 

 

 Installing TREX with Shell Scripts 
Use 

• Running Shell Scripts on UNIX [Page 29] 

• Running Shell Scripts on Windows [Page 29] 

 

 

 Running Shell Scripts on UNIX 
Use 
The installation is done by the install.sh installation script with specific options. 
 

Prerequisites 
You have downloaded and extracted the TREX binaries as described in Download the TREX 
binaries [Page 21]. 

 

Procedure 
1. Log on to the installation host as root user. 

2. Navigate to the directory <path to unpack 
directory>/tx_trex_content/TX_LINUX_X86_64. 

This directory was created by unpacking the TREX software package using SAPCAR. 

3. Call the install.sh installation script (depending on your shell) as follows: 
./install.sh --action=install --sid=<SAPSID> --
password=<password for adm/service user> --type=DEFAULT 

The installation procedure will take less than 15 minutes. You can find more information 
about using the installation script executing it with the --help parameter: 
./install.sh --help 

4. After the installation has finished you need to start TREX: 

Log on as <sapsid>adm user. 

• To start TREX type TREX start. 

• To stop TREX (if necessary), enter TREX stop. 

 

 Running Shell Scripts on Windows 
Use 
The installation is done by the install.cmd installation script with specific options. 
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Prerequisites 
You have downloaded and extracted the TREX binaries as described in Download the TREX 
binaries [Page 21]. 

 

Procedure 
1. Log on to the installation host as a user with administrator rights. 

2. Open a command prompt.  

 
You must run the command prompt as an administrator. 

3. Navigate to the directory <drive>:\<path to unpack 
directory>\tx_trex_content\TX_WINDOWS_X86_64. 

This directory was created by unpacking the TREX software package using SAPCAR. 

4. Call the install.cmd installation script (depending on your shell) as follows: 

install.cmd --action=install --sid=<SAPSID> --password=<password 
for adm/service user> --type=DEFAULT 

The installation procedure will take less than 15 minutes. You can find more information 
about using the installation script executing it with the --help parameter: 
install.cmd --help 

5. After the installation has finished you need to start TREX: 

Open a command prompt and log on as <sapsid>adm user. 

• To start TREX, enter TREX start. 

• To stop TREX (if necessary), enter TREX stop. 

 

 Installing an additional TREX Instance 
Use 
You install an additional TREX instance by means of the TREX script addinstance.cmd 
(Windows) or instance.sh (UNIX).  

The TREX system (first TREX instance together with the global file system (SAP system 
directory)) on the one hand and the newly-installed TREX instance on the other hand form a 
unit from an administration perspective. This is visible in that they both have the same system 
ID (<SAPSID>) and use the same global file system. 

The script is located in the following directory  

○ On UNIX /<SAP System Mount Directory>/<sapsid>/SYS/global/ 
trex/install 

○ On Windows <SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\global\ 
trex\install 

 
This directory is part of the global file system (SAP system directory) 
usr\sap\<SAPSID>\SYS, which must be highly available. All instances of a 
TREX system must have permanent access to it. The global file system must be 
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accessible from all hosts on which you intend to install additional TREX 
instances. 

Prerequisites 
You have mounted (UNIX) or shared (Windows) the directory 
<SAPSID>\SYS\global\trex\install on the host where you intend to install the additional 
TREX instance so that the directory is accessible from this host. 

 

 

Procedure 
... 

1. Log in as root (UNIX) or local administrator (Windows) on the host where the 
additional TREX instance shall be installed and open a command prompt. 

2. Navigate to the directory \...\<SAPSID>\SYS\global\trex\install which is located on 
the host where you have installed TREX initially. On UNIX you have to mount this 
directory manually. 

3. Execute the script addInstance.cmd (Windows) or instance.sh (UNIX) in this 
directory. 

The script will automatically do the following: 

• Creating a directory structure for SAPSID and TREX instance 

• Creating a <SAPSID>adm user 

• Configuring the SAP system 

• Deploying binaries 

• Creating host configuration 

• Registering with TREX Landscape 

• Registering Service sapstartsrv and starting TREX 

Result 
After executing the script an additional TREX instance was installed on the host. You do not 
need to do additional configuration steps.  

 

 Installing TREX with a Virtual Host Name 
Use 
You can install TREX with a virtual host name by using shell scripts. 

Prerequisites 
The virtual host name must be valid at the operating system level and in the network the host 
is a part of. It can be a new primary host name, an additional alias name, or it’s IP address. 
The host must be accessible with this name using the ping command. Only then TREX can 
monitor itself and can be used by other applications. 

Procedure with Shell Scripts 
1. Log on to the installation host: 
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• UNIX: As root user. 

• Windows: As a user with administrator rights. 

2. Navigate to the directory to which you unpacked the TREX binary files: 

• UNIX: <path to unpack 
directory>/tx_trex_content/TX_LINUX_X86_64. 

• Windows: <drive>:\<path to unpack 
directory>\tx_trex_content\TX_WINDOWS_X86_64 

This directory was created by unpacking the TREX software package using SAPCAR. 

3. Call the install.sh installation script (depending on your shell) as follows: 

• UNIX: ./install.sh --action=install --sid=<SAPSID> --
password=<password for adm/service user> --type=DEFAULT  
--host<virtual_hostname> 

The installation procedure will take less than 15 minutes. You can find more 
information about using the installation script executing it with the --help 
parameter: ./install.sh –help 

• Windows: install.cmd --action=install --sid=<SAPSID> --
password=<password for adm/service user> --type=DEFAULT 
--host<virtual_hostname> 

The installation procedure will take less than 15 minutes. You can find more 
information about using the installation script executing it with the --help 
parameter: ./install.sh –help 

4. After the installation has finished you need to start TREX: 

Log on as <sapsid>adm user. 

• To start TREX type TREX start. 

• To stop TREX (if necessary), enter TREX stop. 

 
... 

 

 Update 
Purpose 
You can update TREX in one of the following ways: 

• By running shell scripts [Page 31]. 

 

 

 Updating TREX with Shell Scripts 
Use 
The update software package of TREX is named TREX Revision. The TREX Revision 
numbers no longer follow the SP stacks. Nevertheless, you download the TREX Revision 
update from the SP stack download page as described in section Downloading the TREX 
Software Package [Page 21] in order to get the TREX update packages appropriate to the 
corresponding SP stack. 
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Prerequisites 
You have installed at least one previous TREX 7.10 release (Version 7.10.XX.XX) : 

● If you have already installed TREX, refer to the TREX admin tool Landscape → Hosts  
→ Version to find the version of your TREX installation (see Starting the TREX Admin 
Tool [Page 53]). 

● If you do not have TREX installed at all, install TREX 7.10 from scratch as described in 
this guide in section Installation and Update [Page 27]. 

 
In a distributed scenario, all TREX systems must have the same TREX release 
with the same patch level. Mixed installations with different TREX releases are 
not supported. 

● You have downloaded and extracted the TREX binaries with the target version to 
which you want to update your TREX installation. For more information, see Download 
the TREX binaries [Page 21]. 

 

Procedure 
1. Log on to the TREX host: 

• UNIX: As root user. 

• Windows: As a user with administrator rights. 

2. Navigate to the directory to which you unpacked the TREX binary files: 

• UNIX: <path to unpack 
directory>/tx_trex_content/TX_LINUX_X86_64. 

• Windows: <drive>:\<path to unpack 
directory>\tx_trex_content\TX_WINDOWS_X86_64 

This directory was created by unpacking the TREX software package using SAPCAR. 

3. Call the install.sh installation script (depending on your shell) as follows: 

• UNIX: ./install.sh --action=update --sid=<SAPSID> --
password=<password for adm/service user> --restart 

The installation procedure will take less than 15 minutes. You can find more 
information about using the installation script executing it with the --help 
parameter: ./install.sh –help 

• Windows: install.cmd --action=update --sid=<SAPSID> --
password=<password for adm/service user> --restart 

The installation procedure will take less than 15 minutes. You can find more 
information about using the installation script executing it with the --help 
parameter: ./install.sh –help 

4. If the option restart wasn’t used, after the installation has finished you need to restart 
TREX: 

UNIX:  Log on as <sapsid>adm user. 

• To stop TREX type TREX stop. 

• To start TREX, enter TREX start. 

Windows:  Log on as Administrator. 
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Restart SAP<TREX SID>_<TREX Instance Number> Service. 

 

 

 TREX Basic Configuration 
The TREX basic configuration comprises the following areas: 

● Wizard-Based Basic Configuration for TREX [Page 34] 

The configuration wizard enables the automatic configuration of the settings that are 
required if the application using TREX communicates with TREX using an HTTP or 
RFC connection. 

● TREX Post-Installation Configuration [Page 35] 

After installing TREX, you carry out various technical configuration steps that are 
required so that TREX runs correctly with the standard configuration on a single-host 
system and so that it can be used by an SAP application. 

● Connecting TREX with an Application [Page 43] 

TREX can communicate with the application using it by means of an HTTP connection 
or an RFC connection. There are therefore two procedures for connecting TREX with 
the application using it: 

○ Connecting TREX with a Java Application (HTTP Connection) [Page 50] 

○ Connecting TREX with an ABAP Application (RFC Connection) [Page 44] 

 

 

 Wizard-Based Basic Configuration for TREX 
Use 
The configuration wizard enables the automatic configuration of the settings that are required 
so that the application using TREX can communicate with TREX using an HTTP connection. 

 
Only execute template-based configuration if you have not configured TREX 
previously. 

 
The wizard-based configuration of the settings that are required to enable the 
application using TREX to communicate with TREX using an RFC connection is 
not currently supported. You therefore carry out the configuration steps required 
for this manually (more information: Connecting TREX with an ABAP Application 
(RFC Connection) [Page 44]). 

Procedure 
... 

1. Call the wizard-based configuration tool as described in the Configuration Wizard 
documentation.  

2. Once you have selected the functional units that you want to configure using the 
configuration wizard, the Usage Type Overview – Selection of Configuration Flavors 
screen appears. Select Connect TREX in Further configuration tasks. 
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3. After completing additional configuration steps, you reach the Specifying the Address of 
the TREX Name Server page. Enter the address of one or more TREX name servers. 
A TREX name server controls and monitors the HTTP connection between TREX and 
the application using TREX. 

Result 
You have used the configuration wizard to configure the HTTP connection between TREX 
and the application using it. You can also carry out the configuration steps of the wizard-
based configuration manually.  

For information on this, see the following documentation: 

● Connecting TREX with an Application [Page 43] 

○ Connecting TREX with an ABAP Application (RFC Connection) [Page 44] 

○ Connecting TREX with a Java Application (HTTP Connection) [Page 50] 

 
You carry out these steps manually if you have already carried out the wizard-
based basic configuration previously and now want to configure settings at a 
later time. 

 TREX Post-Installation Configuration 
Purpose 
After installing TREX, you carry out various technical configuration steps that are required so 
that TREX runs correctly with the standard configuration on a single-host system and so that 
it can be used by an SAP application. 

 

 Starting the TREX Admin Tool 
Prerequisites 
On UNIX: Since the TREX admin tool has a graphical interface, you need an X server. You 
cannot use a terminal program that only supports text mode, such as telnet. 

Procedure 
... 

1. Log on with the user <sapsid>adm. 

2. Carry out one of the following steps: 

Operating system Procedure 

UNIX Enter the following: 
cd <TREX_DIR> 

./TREXAdmin.sh  

Windows Start the TREX admin tool by double-clicking 
<TREX_DIR>\TREXAdmin.bat in Windows Explorer. 
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 Configuring the TREX Web Server 
Use 
Java applications that use TREX communicate with the TREX servers using HTTP/HTTPS by 
means of a Web server that has TREX-specific functions. After installing TREX, you have to 
configure the TREX Web server so that your Java application can access TREX. 

Prerequisites 
You must have installed a Web server to use a TREX Web server for HTTP communication 
with the application using TREX: 

● UNIX: Apache Web Server 

The TREX delivery includes an Apache Web server. The TREX installation process 
installs this server in the <TREX_DIR>/Apache directory. 

● Windows: Internet Information Server (IIS) 

○ TREX only supports Windows IIS Version 6.0 or higher. 

○ The TREX delivery does not contain the Internet Information Server (IIS), so 
you have to install an IIS  on your TREX host before configuring the TREX Web 
server. 

 
Make sure that the IIS is running correctly. To do so, activate the World Wide 
Web Publishing Service, IIS Admin Service, and HTTP SSL in the Windows 
Services tool. Make sure that the Default Web Site runs on the IIS: To 
check whether this is the case, navigate to Control Panel → 
Administrative Tools → Computer Management → Services and 
Application → Internet Information Services (IIS) Manager.  

○ In a distributed TREX landscape, the password for the <sapsid>adm user 
must be identical on all hosts. This is also the case for the 
SAPService<SAPSID> user. 

Procedure 
... 

1. Start the TREX admin tool (stand-alone). 

(See: Starting the TREX Admin Tool [Page 53]). 

2. In the Landscape Connectivity window, go to the http tab page. 

3. Choose Refresh. 

4. Choose Add HttpServer. 

The Set Admin User and Password window appears.  

 
During the subsequent configuration steps, the system repeatedly asks you for 
the password for the <SAPSID>adm user and the SAP system service user 
(SAPService<SAPSID>). These users and corresponding passwords were 
created during the TREX installation process. 

Various error messages appear in the Configuration Status area of the window, telling 
you that the TREX Web server is not yet fully configured. 

5. Choose Repair All. 

The Set Admin User and Password window appears.  
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6. Choose Repair All again. 

○ The Set SAPService <SAPSID> window appears. 

○ The Set Admin User and Password window appears. 

○ The Repair Results window appears and confirms that the system correctly 
created a TREX Web site and application pool. 

○ The Set Admin User and Password window appears. 

7. Choose Save to save your settings. Choose Reset to restore the previous settings. 

Result 
You have successfully configured the TREX Web server when the message No problems 
found appears in the Configuration Status area of the screen and a green traffic light 
appears. 

 

 Configuring TREX Proxy Settings 
Use 
If there is a proxy server between the TREX servers and the documents to be indexed, 
specify the proxy server and define exclusion rules if necessary. This configuration is 
important if you want to index the following items: 

● Documents on internal servers that can be accessed without a proxy server. 

● Web pages on external servers that can only be accessed using a proxy server. 

Procedure 
... 

1. Start the TREX admin tool [Page 54]. 

2. In the Preprocessor: Admin window, navigate to the Proxy Setting tab page. 

Enter the proxy server in this area of the TREX admin tool. Since the proxy server 
should not be used for internal addresses, define exclusion rules for internal addresses.  

○ Proxy Server – host name and domain of the proxy server 

Example: proxy.mylocation.mycompany.com 

○ Proxy Server Port – port of the proxy server 

Example: 8080 

○ Proxy User – user name needed to access the proxy server 

○ Proxy User Password – password defined for the user ID 

○ Proxy Exclusions – exclusion rules. These rules define when the proxy server is 
not to be used. Separate multiple entries using a semicolon. 

 
Examples of exclusion rules: 

■ Do not use the proxy server to get URLs that end in mycompany.com: 
mycompany.com 

■ Do not use the proxy server to get IP addresses that start with 10: 10. 

 
Do not use asterisks as placeholders. 
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3. Click Save to save your settings. Click Reset to restore the previous settings. 

Result 
You have configured the proxy server and the corresponding exclusion rules. 

 

 Checking Proxy Settings 
Use 
If an application is unable to communicate with TREX, it may be due to the application trying 
to access TREX using a proxy server. If this is the case, you have to change the configuration 
so that access does not take place using the proxy server. 

The procedure depends on the application concerned: 

● SAP Enterprise Portal 6.0 with Content Management 

● Other Java applications based on J2EE 6.40 

Procedure 
... 

SAP Enterprise Portal with Content Management 

Check the settings in the portal at System Administration → System Configuration → Service 
Configuration → Applications (Content Catalog) → com.sap.portal.ivs.httpservice → Services 
→ proxy.  

If a proxy server is entered there, you have to enter the TREX host in the field http – Bypass 
Proxy Servers. 

Other Java applications based on J2EE 6.40 
For other Java applications, you have to check the configuration of the J2EE Engine. The 
proxy settings belong to the Java parameters. If a proxy server is configured in the Java 
parameters, enter the TREX host in the parameter nonProxyHosts. You can choose one of 
the following options: 

● Alternative 1: D"http.nonProxyHosts=<hostname>.<mydomain>|localhost 

For <hostname>.<domain>, enter the host name and domain (if necessary) of the 
TREX host. 

● Alternative 2: D"http.nonProxyHosts=*.<mydomain>|localhost 

You can change the Java parameters using the SAP J2EE Engine GUI Config Tool. For more 
information about using this tool, see the SAP Library at the Internet address help.sap.com 
→ Documentation → SAP NetWeaver 

 
Note that you have to specify the name of the TREX host in the same way both 
on TREX side in the TREX configuration files (topology.ini, 
sapprofile.ini) and in the configuration of the J2EE Engine as described 
above. In case you specify the TREX host name as fully qualified (for example 
PWDF12345.sap.corp) you have to do so on both sides. A mixed usage of 
host names does not work. 
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 Selecting Languages for TREX Language 
Recognition 
Use 
TREX supports the indexing and analysis of documents in different languages. You can select 
languages to be identified by TREX language recognition. 

The language of a document is needed so that the document in question can be placed in the 
correct language version of the index. For each language that you select, TREX creates a 
separate language index. For example, if you select English, German, and French, TREX 
creates one English, one German, and one French language index. 

Procedure 
1. Start the TREX admin tool [Page 54]. 

2. In the Preprocessor: Admin window, navigate to the Languages tab page. 

The Languages for Document Analysis area contains an overview of languages that 
TREX supports. In this area, select the languages that you want TREX to identify by 
means of document analysis. 

 
Only select the languages that are relevant for your scenario. This optimizes 
performance during the language recognition process, and therefore during the 
search and indexing process. The language recognition process gives better 
results if as few languages as possible are used. 

Languages for which TREX only provides restricted support are indicated by an 
asterisk (*). 

 

 Configuring TREX for the System Landscape 
Directory (SLD) 
Use 
A modern computing environment consists of a number of hardware and software 
components that depend on each other with regard to installation, software updates, and 
demands on interfaces. The SAP System Landscape Directory (SLD) simplifies the 
administration of your system landscape. 

The SLD is a server application that communicates with a client application using the 
Hypertext Transfer Protocol (HTTP). The SLD server contains component information, a 
landscape description, and a name reservation, which are based on the standard Common 
Information Model (CIM). The CIM standard is a general schema for describing the elements 
in a system landscape. This standard is independent of any implementation. 

The component description provides information about all available SAP software modules, 
as well as their combination options and dependencies. This includes version numbers, 
current patch level, and dependencies between landscape components. 

 
For more information about the SAP System Landscape Directory, see  

■ SAP Service Marketplace service.sap.com/sld → Media Library 
→ SLD User Manual SAP NetWeaver 
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■ SAP Help Portal help.sap.com/netweaver → SAP NetWeaver 
<Release> → Application Help → SAP NetWeaver Library : Function-
Oriented View → Solution Life Cycle Management → Configuring, 
Working with and Administering System Landscape Dir  

To supply data to the SLD that originates from a system other than a J2EE or ABAP system, 
the executable sldreg is used. The sldreg sends data in XML format using a predefined 
DTD. For this purpose it uses an HTTP connection, as shown in the figure below: 

TREX SAP J2EE Engine

…

XML

sldreg

SLD
HTTP

SAPOSCOL

SAP 
G

atew
ay SLD Bridge

RFC Server
HTTP Servlet

 
On the TREX host, there is an SLD client, which generates an XML file of this type and which 
registers itself with the SLD server using sldreg. 

Prerequisites 
● After the TREX installation, the SLD client and the associated executable files are 

located on your TREX host. 

● The SLD server is running. 

● You or your SLD administrator have generated the SLD configuration files 
slddest.cfg and slddest.cfg.key. 

 
The slddest.cfg.key file is only available if the configuration of sldreg was 
generated using the - usekeyfile parameter.  

● The user specified in the SLD configuration file slddest.cfg belongs to the 
DataSupplierLD user role, in order to have permission to send the files to the SLD. 

Generating SLD Configuration Files 
In case you generate the SLD configuration files (slddest.cfg and slddest.cfg.key) by 
yourself you have to know the host, port, user and password of the SLD server. You generate 
these configuration files by using the executable files which are located on your TREX host. 
... 

1. Set the environment variables required by TREX by executing the following scripts in a 
command prompt in the directory <TREX_DIR>: 
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UNIX 

○ Bourne shell sh, Bourne-again shell bash, Korn shell ksh: 

. TREXSettings.sh 

○ C shell csh: 

source TREXSettings.csh 

Windows 
TREXSettings.bat 

2. Execute the following commands: 

○ Without usekeyfile: sldreg -configure <path>/slddest.cfg 

○ With usekeyfile: sldreg -usekeyfile -configure 
<path>/slddest.cfg 

Copying the SLD Configuration Files to the Global SLD 
Directory 
... 

To configure TREX for the System Landscape Directory (SLD), you copy the SLD 
configuration files slddest.cfg and slddest.cfg.key (if available) to the global SLD 
directory on your TREX host. 

This directory is called <disk_drive>:\usr\sap\<SAPSID>\SYS\global on Windows and 
/usr/sap/<SAPSID>/SYS/global on UNIX. In the case of a distributed TREX installation on 
Windows, all TREX instances use the configuration files for the TREX global file system with 
first TREX instance as \\<host_central_instance>\sapmnt\<SAPSID>\SYS\global. 

Result 
By copying the files slddest.cfg and slddest.cfg.key, you have configured TREX for 
integration in the System Landscape Directory (SLD).  

TREX checks every five minutes whether anything has changed in the TREX system 
landscape and reports any changes automatically to the SLD server. If nothing has changed, 
TREX reports every twelve hours to the SLD server. This allows you to see that this 
landscape is still active. 

Display Results 
... 

1. To display the information about TREX systems and services navigate to the screen 
Content Maintenance 

○ In the initial screen for the System Landscape Directory  → Development: 
Content Maintenance 

○ In the initial screen for the System Landscape Directory  → Administration  → 
Content: Content Maintenance 

2. In the screen Content Maintenance navigate to Subset and choose All With Instances 
in the dropdown list. 

3. Navigate to Class. In the dropdown list you can display the TREX Services (for example 
TREX Index Service, TREX Name Service) and TREX systems known by SLD. 

Information Transferred to the SLD Server 
TREX transfers the following information to the SLD server: 

Information about naming and version 

● Software component version (for example, TREX 7.1) 
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● SAP name (for example, TREX) 

● Version (for example, 7.1) 

Information about the TREX servers 

● Host name, on which the server is running 

● Port number that the server is using 

● Type of server, for example, indexserver 

● Web server URL (instead of the port) 

● RFC destination of the RFC server (instead of the port) 

Information about the TREX instances on individual hosts 

● System ID 

● Instance number 

● Installation directory 

● Version information for the TREX software 

Information about the TREX configuration 

● Name of the TREX hosts (Hosts) that belong to the TREX system landscape 

● TREX server roles 

○ Roles of the TREX name server (Name Server Mode) 

Possible roles are: 1st, 2nd, 3rd Master Name Server, Slave Server 

○ Use as master index server or master queue server 

○ Roles of the master, slave, and backup index servers 

● TREX preprocessor mode (Preprocessor Mode) 

● Information about the TREX installation directory (Base Path) 

● Services that have been started by the TREX daemon (Services) 

 

 

 Checking Performance Settings for the Operating 
System 
Use 
To optimize the performance of TREX when using the released Windows platform, you need 
to check your Windows configuration and make changes if necessary. 

Optimizing Data Throughput For Network Applications 
The Windows installation normally makes caching settings that are optimized for file servers. 
The operating system then reserves a large part of the main memory for the caching of files. 
Since this file-system cache impairs performance when indexing, you ought to change these 
settings. 
... 

1. Use the secondary mouse button to click on My Network Places on the Windows 
desktop, and choose Properties. 
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2. Use the secondary mouse button to click on the local network connection and choose 
Properties. 

3. Select the entry File and Printer Sharing for Microsoft Networks and choose Properties. 

4. Select Maximize data throughput for network applications. 

5. Choose OK twice. 

Optimizing Performance for Background Processes 
 

Programs such as Microsoft SQL Server and Microsoft Exchange make the 
setting described below automatically when they are installed. If you have 
installed one of these programs, you do not need to make any changes. 

The setting is only relevant if TREX is running as a Windows service. 
... 

Windows  
... 

1. Use the secondary mouse button to click on This PC and choose Properties. 

2. Choose the Advanced system settings , and then choose  Advanced. 

3. Select Background services under Adjust for best performance of. 

4. Choose OK twice. 

 

 

 Connecting TREX with an Application 
Procedure 
TREX can communicate with the application using it by means of an HTTP connection or an 
RFC connection: 

● An ABAP application accesses TREX by means of an ABAP client (RFC connection) 

As a rule, ABAP applications communicate with the TREX servers by means of the 
TREX ABAP client using the RFC/SNC protocol. Communication takes place using an 
instance of the SAP Gateway and an RFC server. 

● A Java application accesses TREX by means of a Java client (HTTP connection) 

As a rule, Java applications communicate with the TREX servers by means of the 
TREX Java client using the HTTP or HTTPS protocol. This communication takes place 
using a Web server that is enhanced with TREX-specific functions. 
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There are therefore two procedures for connecting TREX with the application using it: 

● Connecting TREX with an ABAP Application (RFC Connection) [Page 44] 

● Connecting TREX with a Java Application (HTTP Connection) [Page 50] 

 

 Connecting TREX with an ABAP Application (RFC 
Connection) 
As a rule, ABAP applications communicate with the TREX servers by means of the TREX 
ABAP client using the RFC/SNC protocol. Communication takes place using an instance of 
the SAP Gateway and an RFC server. You configure the RFC connection using the TREX 
admin tool (stand-alone). 

 

 Creating a SAP System User for the TREX Admin 
Tool (Stand-Alone) 
Use 
You must create an SAP user that the TREX admin tool (stand-alone) can use to log on to the 
SAP system. In addition, the SAP user is required so that the TREX alert server has 
permission to regularly test and check the RFC configuration. When doing this, the user can 
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have been created in the default client or in another client. In this case, make sure that you 
enter the associated client for the user during the configuration of the RFC connection in the 
TREX admin tool [Page 47]. 

The TREX admin tool (stand-alone) is used to configure and monitor TREX. You also use this 
admin tool to configure the RFC connection between TREX and the ABAP application that is 
using TREX. To use the TREX admin tool (stand-alone) to create the RFC destination, the 
admin tool requires an SAP system user that you create based on the predefined role 
SAP_BC_TREX_ADMIN. This user then has the authorization required to configure the RFC 
connection. 

 
For more information about the SAP_BC_TREX_ADMIN role, see SAP Note 
766516. 

Overview of the Permissions Assigned by the SAP_BC_TREX_ADMIN Role 

Type and Scope of the 
Permission 

Activity Explanation 

Permission check  
for RFC access 

Execute Name of the RFC object to be 
protected: SYST, 
TREX_ARW_ADMINISTRATION 

Administration for the  
RFC destination 

Add or generate, change, 
display, delete, extended 
maintenance 

Type of entry in RFCDES: Start of an 
external program using TCP/IP 

Check on the transaction 
code at transaction launch 

 Transaction code: SM59, 
TREXADMIN, TREXADMIN_AUTH 

Administrating TREX Change, display, execute  

ABAP: Program run checks Schedule programs for 
background processing, 
execute ABAP program, 
maintain variants for and 
execute ABAP program 

 

ALV standard layout Maintain  

Application log Display, delete  

More Information 
Configuring the RFC Connection in the TREX Admin Tool [Page 45] 

Procedure 
Create an SAP system user for the TREX admin tool (stand-alone) and assign the 
SAP_BC_TREX_ADMIN role to this user. 
... 

1. Launch transaction SU01 (user maintenance) or choose Administration → System 
Administration → User Maintenance → User in the SAP menu. The User Maintenance: 
Initial Screen appears. 

2. Enter a new user name and choose Create. 

3. On the Address tab page, enter the personal data for the user. 

4. On the Roles tab page, assign the SAP_BC_TREX_ADMIN role and thus the permission 
to access the SAP system to the SAP system user for the TREX admin tool (stand-
alone). 
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Result 
This user for the TREX admin tool (stand-alone) now has the authorization required to 
configure the RFC connection. 

 

 

 Determining the SAP System Connection 
Information 
Use 
The TREX admin tool (stand-alone) can connect to an SAP system in two ways. 

● Through a specific application server of the SAP system (variant A) 

● Through the message server of the SAP system (variant B) 

This variant uses the load-balancing function for the SAP system. The message server 
assigns the request from the TREX admin tool to any application server. 

Depending on the variant used, the TREX admin tool requires different connection information 
for the SAP system. You must determine the connection information and specify it later in the 
TREX admin tool. 

 
SAP recommends using variant B. Variant A has the disadvantage that the 
connection does not work if the application server is not available. 

Procedure 
... 

1. Open the SAP Logon. 

SAP Logon is the program that you use to log on to an SAP system. 

2. Note the following connection information: 
... 

Connection Setup Type Required Connection Information 

Through an application server (variant 
A) 

● SAP system ID (SID) 

● System number 

● Application server host name 

Through the message server (variant B) ● SAP system ID (SID) 

● Logon group, such as PUBLIC 

● Message server host name 

 

 

 Configuring the RFC Connection in the TREX 
Admin Tool 
Use 
You work through the steps below using the TREX admin tool (stand-alone). 
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Configuration of the RFC connection with the TREX admin tool (stand-alone) is 
only available as of SAP Basis Component SAP_BASIS 6.20 SP58, 6.40 SP16, 
and 7.0 SP6. If you are using TREX with an SAP system based on an earlier 
support package, you have to configure the RFC connection manually as 
described in the SAP NetWeaver 04 Installation Guide for Search and 
Classification (TREX) 6.1. You can find this guide on the SAP Service 
Marketplace at service.sap.com/instguides → SAP NetWeaver → Released 
04 → Installation → Cross-NW → Installation Guide Search and Classification 
TREX 6.1. 

Creating a Connection 
... 

1. On the RFC: Current tab page in the Landscape: Connectivity window, choose the 
Create Connection function. 

2. Choose connection type A or B. Specify the connection data for the SAP system (see 
Determining the SAP System Connection Information [Page 46]). 

3. Specify the SAP system user, the associated password, and the client that the TREX 
admin tool is to use to log on (see Creating a SAP System User for the TREX Admin 
Tool (Stand-Alone) [Page 45]). 

 
If the SAP system user in question exists in the default client, you do not need to 
specify the client.  

 

Creating an RFC Destination 
... 

1. To do this, use the Create: RFC Destination (SM59) function on the RFC: Current tab 
page in the Landscape: Connectivity window. 

2. Enter the following parameters: 

Field Entry 

SAP System  SAP system that you want to set up the connection to.  

The list contains all SAP systems that you have registered 
using Create Connection.  

RFC Destination  Name of the RFC destination. 

Description  Meaningful description of the purpose  

The program ID determines under which name the TREX RFC server registers with the 
SAP gateway. The program ID must be unique for each SAP gateway. The TREX 
admin tool ensures this by generating the program ID.  

 

3. Decide which SAP gateway you want to use. You have the following options: 

Option Comment 

Gateway local  

(Default setting)  

Use local SAP gateways for the application servers. 
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Gateway central  Use the central SAP gateway. 

 
We advise against using a central SAP gateway 
for distributed TREX systems. The central SAP 
gateway is a “single point of failure.” 

If you choose this option, enter the following additional 
parameters: 

● Host name (with domain name if necessary) or the IP 
address of the host on which the gateway is installed. 

● Name of the SAP gateway in the form 
sapgw<instance_number> 

 

 
We advise against creating the RFC destination directly in the SAP system. The 
name of the RFC destination and the program ID must satisfy certain naming 
conventions. The TREX admin tool ensures that these are fulfilled. 

If you nevertheless create the RFC destination directly in the SAP system, note 
the following: 

● We recommend starting the name of the RFC destination with 
TREX_. 

● Choose the activation type Registered Server Program. 

● Choose a program ID that is unique for the SAP gateway used. 

● Use the RFC Destinations function to register the RFC destination 
in the TREX admin tool. 

 

Completing the RFC Configuration 
... 

1. On the RFC: Current tab page in the Landscape: Connectivity window, choose the 
Connect Admin Tool function. 

The TREX admin tool creates the connection to all SAP systems that are known to it. 
Because the RFC configuration is still incomplete, the configuration status is  yellow 
or  red.  

 

2. Choose Repair All. 

The TREX admin tool completes the RFC configuration and starts the TREX RFC 
server.  

This can take several minutes. During this time, the configuration status remains  
yellow or  red. After completion of the configuration process, the status changes to 

 green. 

 

 
Do not choose Repair All several times in quick succession. This would trigger 
the configuration process more than once and delay it.  

 

3. Check the progress by choosing Refresh to update the display. 



Search and Classification TREX                                                                           Januar  2022 

 

Installing and Updating TREX – Single Host  48 

 

 

 

 Connecting TREX with a Java Application (HTTP 
Connection) 
As a rule, Java applications communicate with the TREX servers by means of the TREX Java 
client using the HTTP or HTTPS protocol. This communication takes place using a Web 
server that is enhanced with TREX-specific functions. The TREX Java client needs to know 
the address of the TREX name server in order to communicate with the TREX servers. You 
specify the address of the TREX name server, and, in the case of a distributed TREX 
installation, of the TREX backup name server, in the SAP NetWeaver Administrator. 

 

 Specifying the Address of the TREX Name Server 
Use 
TREX provides APIs (Application Programming Interfaces) for the languages Java and ABAP, 
which allow access to all TREX functions. The Java interface (TREX Java client) is part of the 
SAP Web AS Java as TREX service. The TREX Java client needs to know the address of the 
TREX name server in order to communicate with the TREX servers.  

The following procedure describes how you determine the TREX name server address and 
how you specify it in the SAP NetWeaver Administrator. 

 
The TREX Java client communicates with the TREX server by HTTP and 
TCP/IP. Make sure that the TCP port that the name server uses is open.  

Procedure 
... 

You have to specify the address of the TREX name server in the SAP NetWeaver 
Administrator by naming the following values 
<host_name_of_trex_host>:<name_server_port>: 

● <host_name_of_trex_host>: name of the host on which TREX is installed and 
where the TREX name server runs. 

● <name_server_port>: port of the TREX name server 

1. You can determine the TREX name server address in two ways: 

a. Start the TREX admin tool (see Starting the TREX Admin Tool [Page 54]) and 
determine the address of the name server using Landscape  → Tree →  
topology → globals → all_masters. 

 
For example: mytrexhost:34801 

b. Determine the port of the TREX name server by means of the following rule: 
<name_server_port>: 3<instance_number>01 

 
The value <instance_number> signifies the TREX instance number which 
had been specified during the TREX installation: 

Installation directory for TREX 
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■ On UNIX /usr/sap/<sapsid>/trx<instance_number> 

■ On Windows 
<disk_drive>:\usr\sap\<SAPSID>\TRX<instance_number> 

The value for <host_name_of_trex_host> you know from the host where 
TREX is installed (mytrexhost). 

2. Use the user <j2eeadm> to log onto the host on which the Application Server Java is 
running. 

3. Start the SAP NetWeaver Administrator and log on to the AS Java . 

 
For more information about using and starting the SAP NetWeaver 
Administrator, see SAP NetWeaver Administrator documentation on SAP Help 
Portal help.sap.com. 

4. Navigate to Configuration Management → Infrastructure Management → Java System 
Properties. 

5. In the new screen go to the tabulator Services in the screen area Details and type in 
trex.service to filter the available services. 

6. In the Extended Details area under the tabulator Properties enter the address of the 
TREX name server into the parameter nameserver.address: 
tcpip://<host_name_of_trex_host>:<name_server_port> 

You enter only the host name or the host name and the domain depending on your 
network environment. 

 
tcpip://mytrexhost:34801 or tcpip://mytrexhost.mydomain:34801  

 
The address of the TREX name server must be configured for all server 
processes of the cluster. Otherwise the connection between the AS Java and 
TREX cannot be established. 

7. In case of a multiple host scenario for a distributed TREX landscape you enter the 
addresses of the TREX backup name servers in the parameter 
nameserver.backuplist. Specify the address of the TREX backup name servers, 
separated by comma in the format: 
tcpip://<host1>:<port1>,tcpip://<host1>:<port1>, … 

 
For a TREX single-host installation you do not need to specify backup name 
servers. 

8. Save your changes and confirm the restart of the service. 

 

 Installation Check 
Purpose 
If you have carried out all the steps described, TREX is ready for operation. You can carry out 
checks to ascertain whether the installation was successful. 
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 Checking Processes 
Use 
You can check on operating systems whether the TREX daemon is running and whether the 
required process has started.  

Procedure 
On UNIX 
... 

Log on with the user <sapsid>adm. Use ps –fu <sapsid>adm, to check whether the 
following processes are running. If TREX had been successfully installed, you can use the 
command TREX info to display all currently running TREX processes. 

Process HTTP Connection RFC Connection 
httpd   

TREXDaemon.x 

 

 
For the process TREXDaemon.x the 
symlink trx.sap<SAPSID> 
_TRX<instance_number> will be shown. 
This is a symlink to 
usr/sap/<SAPSID>/TRX<instance_nu
mber>/exe/TREXDaemon.x 

  

TREXIndexServer.x   

TREXNameServer.x   

TREXPreprocessor.x   

TREXQueueServer.x   

TREXRfcServer.x   

On Windows 
Open the Task Manager and check whether the following programs are running: 

Process HTTP Connection RFC Connection 
TREXDaemon.exe   

TREXIndexServer.exe   

TREXNameServer.exe   

TREXPreprocessor.exe   

TREXQueueServer.exe   

TREXRfcServer.exe   
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 Executing an Installation Test Script 
Use 
TREX delivers a Python script that you can use to test the basic functions of TREX. If the 
Python script is executed successfully, you know that TREX has been installed properly, the 
configuration files contain the necessary entries, and the TREX servers are running.   

Procedure on UNIX 
... 

1. Log on with the user <SAPSID>adm. 

2. Go to the TREX directory. 
cd  /usr/sap/<SAPSID>/trx<instance_number> 

3. Set the environment variables required by TREX by executing one of the following 
scripts. 

○ Bourne shell sh, Bourne-again shell bash, Korn shell ksh: 
. TREXSettings.sh 

○ C shell csh: 
source TREXSettings.csh 

4. Go to the directory in which the test script is located: 
cd  /usr/<SAPSID>/trx<instance_number>/exe/python_support 

5. To run the test script, enter the following: 
python runInstallationTest.py 

Procedure on Windows 
... 

1. Log on with the user <SAPSID>adm. 

2. Go to the TREX directory. 
cd  /usr/sap/<SAPSID>/TRX<instance_number> 

3. Set the environment variables required by TREX by executing the following script: 
TREXSettings.bat 

4. Go to the directory where the installation test script is located in: 
<disk_drive>:\usr\sap\<SAPSID>\TRX<instance_number>\ 
exe\python_support. 

5. Run the test script in this directory: 
python runInstallationTest.py 

Result 
The script carries out the following tests: 

● Deleting any test indexes that were generated for a previous script run 

● Creating a test index 

● Indexing documents 

● Testing search functions 

○ Exact, error-tolerant (fuzzy), and linguistic searches 

○ Search using Boolean operators such as AND and OR 
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The results are displayed at the end of the script run. You see the tested calls and their 
statuses (OK or Failed). 

When you run the script for the first time, the call “Delete Index” has the status Failed. This is 
because there was no existing text index to be deleted. If this is the only cell with the status 
Failed, the test was successful. 

 

 

 Additional Information 
Purpose 
The sections below contain information on the following topics: 

● Starting the TREX admin tool 

● Starting and stopping TREX 

● Uninstalling TREX 

 

 
... 

 

 Starting the TREX Admin Tool 
Prerequisites 
On UNIX: Since the TREX admin tool has a graphical interface, you need an X server. You 
cannot use a terminal program that only supports text mode, such as telnet. 

Procedure 
... 

1. Log on with the user <sapsid>adm. 

2. Carry out one of the following steps: 

Operating system Procedure 

UNIX Enter the following: 
cd <TREX_DIR> 

./TREXAdmin.sh  

Windows Start the TREX admin tool by double-clicking 
<TREX_DIR>\TREXAdmin.bat in Windows Explorer. 

 
... 

 Starting and stopping TREX 
You use the following methods to start and stop TREX: 

Windows 

● TREX admin tool (standalone) 

● The executable files startsap.exe and stopsap.exe 
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● The SAP Management Console 

 
As of TREX 7.10, the SAP Management Console is a snap-in in the Microsoft 
Management Console (MMC) and is no longer part of the TREX installation. To 
start TREX with the SAP Management Console, you must have installed the 
console in your TREX system first. 

UNIX 

● TREX admin tool (standalone) 

● The shell scripts startsap and stopsap 

Starting and Stopping the TREX Web Server and Individual TREX 
Servers 
When administrating TREX, you may need to stop (and then restart) the TREX Web server 
(Windows: IIS/UNIX: Apache) and individual TREX servers. The procedures differ depending 
on whether you are using Windows or UNIX. 

 

 Starting and Stopping TREX on Windows 
Purpose 
The following sections explain how to start and stop TREX on Windows: 

On Windows, you can use the following methods to start and stop TREX: 

● TREX admin tool (standalone) 

● The executable files startsap.exe and stopsap.exe 

● The SAP Management Console (SAP MC) 

● The SAP Microsoft Management Console (MMC) 

 
As of TREX 7.10, the SAP Management Console is a snap-in in the Microsoft 
Management Console (MMC) and is no longer part of the TREX installation. To 
start TREX with the SAP Management Console, you must have installed the 
console in your TREX system first. 

The executable files startsap.exe and stopsap.exe 
You use the executable files startsap.exe and stopsap.exe to start and stop TREX. 
Following the installation of the TREX instance, these files are located in the 
<TREX_DIR>\exe directory and are executed from that directory. 

The SAP Management Console  
The SAP Management Console (SAP MC) provides a common framework for centralized 
system management. It allows you to monitor and perform basic administration tasks on the 
SAP system centrally, which simplifies system administration. 

The SAP MC is a Java applet that can be run from any Web browser supporting Java. You 
can therefore administer remote systems without needing a local installation. 

 
For more information about the SAP Management Console, see the online 
application help and the SAP Library in the SAP Help Portal at 
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help.sap.com/netweaver → SAP NetWeaver <Release> → Application 
Help → SAP NetWeaver : Function-Oriented View →  Solution Lifecycle 
Management → SAP Management Console  

 

The SAP Microsoft Management Console  
You use the SAP Microsoft Management console, a snap-in in the Microsoft Management 
Console (MMC), to start and stop SAP systems and TREX instances. The snap-in consists of 
a root node of the SAP system, below which the various SAP systems and their TREX 
instances appear as subnodes. The system displays detailed information about the 
processes, the current status, and open alerts for the instances. 

 
A newly-installed MMC allows you only to start a locally-installed SAP instance 
on the host that you are logged on to. If the MMC is configured for central 
system administration, you can start and stop the entire SAP system from a 
single host. 

 
For more information about the SAP Management console and the snap-in for 
the MMC, see the online application help and the SAP Library in the SAP Help 
Portal at help.sap.com/netweaver → SAP NetWeaver <Release> → 
Application Help → SAP NetWeaver : Function-Oriented View →  Solution 
Lifecycle Management → SAP Microsoft Management Console Windows  

As part of the installation of the global file system, the SAP service for the corresponding 
TREX instance (SAP<sapsid>_TRX<instance_number>) is registered as a Windows 
service. The service is configured so that it starts automatically when the host is started up, 
and stops automatically when the host is shut down. You can start and stop the service 
manually if necessary. You can also start the TREX servers individually for test purposes or 
troubleshooting. 

Prerequisites 
During the installation of the global file system, a SAP Management console has been 
installed on your host machine. 

 

 Starting TREX 
The following sections describe in detail how to start TREX in the different ways listed above. 

 

Starting TREX with the TREX Admin Tool 
... 

1. Log on with the user <sapsid>adm. 

2. Start the TREX admin tool by double-clicking <TREX_DIR>\TREXAdmin.bat in Windows 
Explorer. 

3. In the TREX admin tool, navigate to the Landscape Services area and then go to the 
MMC tab. 

4. You can start TREX by clicking the SAP System: Start button or by selecting the TREX 
host, opening its context menu with the secondary mouse button, and selecting the 
relevant option. You can start Selected Hosts or All Hosts for a landscape. 

Starting TREX with startsap.exe 
... 
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1. Log on with the user <sapsid>adm. 

2. In Windows Explorer, double-click the <TREX_DIR>/TREXSettings.bat batch file to 
set the environment variables correctly. 

3. Go to the <TREX_DIR>/exe directory and enter the following: 

startsap.exe name=<SAPSID> nr=TRX<instance_number> SAPDIAHOST 
=<host> 

In the SAPDIAHOST parameter, you specify the host name on which the TREX instance 
should be started. 

 
startsap.exe name=ABC nr=TRX77 SAPDIAHOST =p123456 

Starting TREX with the SAP Management Console 
Starting the Web-Based SAP Management Console 

1. Start a Web browser and enter the following URL: 
http://<hostname>:5<instance_number>13 

 
If the instance number is 53and the host name is saphost06, you enter the following 
URL: http://saphost06:55313 

This starts the SAP MC Java applet. 

 
If your browser displays a security warning message, choose the option that indicates 
that you trust the applet. 

2. Choose Start. 

The SAP Management Console appears. 

 
When you start the SAP MC for the first time for a newly installed SAP system, you 
have to register your system as described in Registering Systems and Instances 
below. After you have done this, the instances installed on the host you have 
connected to are already present in the SAP Management Console when you next 
start the SAP MC. 

Registering Systems and Instances in the SAP Management Console 
You can extend the list of systems and instances displayed in the SAP MC, so that you can 
monitor and administer all systems and instances from a single console. You can configure 
the SAP MC startup view to display the set of systems and instances you want to manage. 

1. In the SAP MC, choose File → New. 

2. In the New System dialog box, enter the required data. 

 
If you have already registered systems in the SAP MC, they are stored in the history. 
To open the System’s History dialog box, choose the browsing button next to the 
Instance Nr. field. Select an instance of the system that you want to add and choose 
OK. 

3. Choose Finish. 

Starting a TREX Instance 
1. In the navigation pane, open the tree structure and navigate to the system node that 

you want to start. 
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2. Select the system or instance and then, from the context menu, choose Start. 

3. In the Start SAP System(s) dialog box, choose the required options. 

4. Choose OK. 

The SAP MC starts the specified system or system instances. 

 
The system might prompt you for the SAP system administrator credentials. To 
complete the operation, you require administration permissions. Log in as user 
<sapsid>adm. 

5. Start the TREX instance. 

Starting TREX with the SAP Microsoft Management Console 
... 

1. Log on with the user <sapsid>adm. 

2. Launch the SAP Management console by double-clicking the program icon on your 
desktop or by choosing Start → Programs  → SAP Management Console. 

3. In the tree structure, choose the node for the central SAP instance <SAPSID> and 
navigate to the subnode for the TREX instance <host>_<instance_number> (for 
example, p123456_77). 

4. Use the secondary mouse button to access the context menu. 

5. Choose Start. 

 

 

 Stopping TREX 
The following sections describe in detail how to stop TREX in the different ways listed above. 

 

Stopping TREX with the TREX Admin Tool 
... 

1. Log on with the user <sapsid>adm. 

2. Start the TREX admin tool by double-clicking <TREX_DIR>\TREXAdmin.bat in 
Windows Explorer. 

3. In the TREX admin tool, navigate to the Landscape Services area and then go to the 
MMC tab. 

4. You can stop TREX by clicking the SAP System: Stop button or by selecting the TREX 
host, opening its context menu with the secondary mouse button, and selecting the 
relevant option. You can stop Selected Hosts or All Hosts for a landscape. 

Stopping TREX with stopsap.exe 
... 

1. Log on with the user <sapsid>adm. 

2. In Windows Explorer, double-click the <TREX_DIR>/TREXSettings.bat batch file to 
set the environment variables correctly. 

3. Go to the <TREX_DIR>/exe directory and enter the following: 

stopsap.exe name=<SAPSID> nr=TRX<instance_number> SAPDIAHOST 
=<host> 



Search and Classification TREX                                                                           Januar  2022 

 

Installing and Updating TREX – Single Host  57 

 

In the SAPDIAHOST parameter, you specify the host name on which the TREX 
instance is to be stopped. 

 
stopsap.exe name=ABC nr=TRX77 SAPDIAHOST =p123456 

 
Do not use the Task Manager to stop the SAP service or the individual TREX 
servers. Otherwise, data can be lost. Affected indexes can be irreparably 
damaged.  

Certain processing steps, for example, writing an index, cannot be interrupted. 
Such steps are completed before TREX is stopped. This process can take a 
while to complete. With large indexes, it can take up to a few hours to stop the 
TREX servers if lots of documents are currently being indexed. 

Stopping TREX with the SAP Management Console 
1. Start the SAP Management Console as described in Starting the Web-Based SAP 

Management Console [Page 55] 

2. Select the TREX instance you want to stop and choose Stop from the context menu. 

3. In the Stop SAP System(s) dialog box, choose the required options. 

4. Choose OK. 

The SAP MC stops the specified TREX instance. 

 
The system might prompt you for the SAP system administrator credentials. To 
complete the operation, you require administration permissions. Log in as user 
<sapsid>adm. 

Stopping TREX with the SAP Microsoft Management Console 
... 

1. Log on with the user <sapsid>adm. 

2. Launch the SAP Management console by double-clicking the program icon on your 
desktop or by choosing Start → Programs  → SAP Management Console. 

3. In the tree structure, choose the node for the central SAP instance <SAPSID> and 
navigate to the subnode for the TREX instance <host>_<instance_number> (for 
example, p123456_77). 

4. Use the secondary mouse button to access the context menu. 

5. Choose Shutdown. 

 
The Shutdown command only stops the TREX processes once any running 
processes have been completed. Do not use the Stop command, as this 
command terminates the TREX processes immediately, which means that there 
is a risk of data loss. 
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 Starting and Stopping Individual TREX Servers 
Use 
You can start individual TREX servers for test purposes and for troubleshooting. You can then 
track the program output on the screen. 

Starting the TREX Servers 
... 

1. Stop TREX (see Stopping TREX [Page 56]). 

2. Open a separate prompt for each TREX server. 

3. Go to the TREX directory and start the TREX server. 

TREX Server Command 

Index server TREXIndexServer.exe 

Name server TREXNameServer.exe 

Preprocessor TREXPreprocessor.exe 

Queue server TREXQueueServer.exe 

Only relevant for an RFC 
connection: RFC server 

TREXRfcServer.exe -r 

 
In the properties of the prompt, deactivate the QuickEdit Mode option. 

Leave the prompt open. If you want, you can minimize the window so that it is 
shown as a pushbutton in the Windows task bar. 

Stopping the TREX Servers 
... 

1. Display the window in which you started the TREX server. 

2. Use CTRL + C or close the window. 

Certain processing steps, for example, writing an index, cannot be interrupted. Such steps are 
completed before the TREX servers are stopped. This process can take a while to complete. 

With large indexes, it can take up to a few hours to stop the TREX servers if lots of 
documents are currently being indexed. 

 
Do not use the Task Manager to stop the TREX servers. Otherwise, data can be 
lost. Affected indexes can be irreparably damaged.  

 

 

 Starting the Web Server 
Procedure 
... 

1. choose Start → Administrative Tools → Services. 

2. Select IIS Admin Service and choose Start from the context menu. 

If the World Wide Web Publishing Service does not run even though you have started it, try to 
start it using a prompt: 
... 
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1. Open a prompt. 

2. Execute the following command: 
net start w3svc 

 

 

 Stopping the Web Server 
Procedure 

1. choose Start → Administrative Tools → Services. 

2. Select IIS Admin Service and choose Stop from the context menu. 

 

 

 Starting and Stopping TREX on UNIX 
Purpose 
The following sections explain how to start and stop TREX on UNIX. 

On UNIX, you use the startsap and stopsap shell scripts or the TREX admin tool 
(standalone) to start and stop TREX. 

 

 Starting TREX 
Starting TREX with the TREX Admin Tool 

 
On UNIX: Since the TREX admin tool has a graphical interface, you need an X 
server. You cannot use a terminal program that only supports text mode, such 
as telnet. 

... 

1. Log on with the user <sapsid>adm. 

2. Start the TREX admin tool by entering the following: 
cd <TREX_DIR> 

./TREXAdmin.sh 

3. In the TREX admin tool, navigate to the Landscape Services area and then go to the 
MMC tab. 

4. You can start TREX by clicking the SAP System: Start button or by selecting the TREX 
host, opening its context menu with the secondary mouse button, and selecting the 
relevant option. You can start Selected Hosts or All Hosts for a landscape. 

Starting TREX with the Shell Script 
... 

1. Log on locally to the host on which the TREX instance is installed with the user 
<sapsid>adm. 

2. Execute the startsap script in any directory: 
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a. To start a single TREX instance, enter the following: 
startsap TRX<instance_number> 

In the parameter TRX<instance_number>, you specify which TREX instance 
is to be started. 

b. To start all SAP instances – including all TREX instances – on a host, enter the 
following: 
startsap 

 

 Stopping TREX 
Stopping TREX with the TREX Admin Tool 

 
On UNIX: Since the TREX admin tool has a graphical interface, you need an X 
server. You cannot use a terminal program that only supports text mode, such 
as telnet. 

... 

1. Log on with the user <sapsid>adm. 

2. Start the TREX admin tool by entering the following: 
cd <TREX_DIR> 

./TREXAdmin.sh 

3. In the TREX admin tool, navigate to the Landscape Services area and then go to the 
MMC tab. 

4. You can stop TREX by clicking the SAP System: Stop button or by selecting the TREX 
host, opening its context menu with the secondary mouse button, and selecting the 
relevant option. You can stop Selected Hosts or All Hosts for a landscape. 

Stopping TREX with the stopsap Shell Script 
... 

1. Log on locally to the host on which the TREX instance is installed with the user 
<sapsid>adm. 

2. Execute the stopsap script in any directory: 

a. To start a single TREX instance, enter the following: 
stopsap TRX<instance_number> 

In the parameter TRX<instance_number>, you specify which TREX instance 
is to be stopped. 

b. To stop all SAP instances – including all TREX instances – on a host, enter the 
following: 
stopsap 

 

 Starting and Stopping Individual TREX Servers 
Use 
You can start individual TREX servers for test purposes and for troubleshooting. You can then 
track the program output on the screen. 
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Starting the TREX Servers 
... 

1. Log on with the user <sapsid>adm. 

2. Stop TREX (see Stopping TREX [Page 70]). 

3. Go to the TREX directory. 

4. Start each TREX server in a separate shell. 

TREX Server Command 

Index server TREXIndexServer.x 

Name server TREXNameServer.x 

Preprocessor TREXPreprocessor.x 

Queue server TREXQueueServer.x 

Only relevant for an RFC 
connection: RFC server 

TREXRfcServer.x -r 

Stopping the TREX Servers 
... 

1. Display the window in which you started the TREX server. 

2. Use CTRL + C or close the window. 

Certain processing steps, for example, writing an index, cannot be interrupted. Such steps are 
completed before the TREX servers are stopped. This process can take a while to complete. 

With large indexes, it can take up to a few hours to stop the TREX servers if lots of 
documents are currently being indexed. 

 
Do not stop the TREX server using kill – 9, as this can lead to data loss. 
Affected indexes can be irreparably damaged. 

 

 

  
 

 

 Uninstall 
Purpose 
You can uninstall TREX: 

• By running shell scripts [Page 72]. 
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 Uninstalling TREX with Shell Scripts 
Use 
You can uninstall TREX on the released platforms using the installation scripts that are 
contained in the package with the TREX binaries. 

 

Prerequisites 
You have downloaded and extracted the TREX binaries as described in Download the TREX 
binaries [Page 21]. 

 

Procedure 
1. Log on to the TREX host: 

• UNIX: As root user. 

• Windows: As a user with administrator rights. 

2. Navigate to the directory to which you unpacked the TREX binary files: 

• UNIX: <path to unpack 
directory>/tx_trex_content/TX_LINUX_X86_64. 

• Windows: <drive>:\<path to unpack 
directory>\tx_trex_content\TX_WINDOWS_X86_64 

This directory was created by unpacking the TREX software package using SAPCAR. 

3. Call the install.sh installation script (depending on your shell) as follows: 

• UNIX: ./install.sh --action=remove --sid=<SAPSID> --
password=<password for adm/service user> --type=DEFAULT 

The installation procedure will take less than 15 minutes. You can find more 
information about using the installation script executing it with the --help 
parameter: ./install.sh –help 

• Windows: install.cmd --action=remove --sid=<SAPSID> --
password=<password for adm/service user> --type=DEFAULT 

The installation procedure will take less than 15 minutes. You can find more 
information about using the installation script executing it with the --help 
parameter: ./install.sh –help 

4. After the installation has finished you need to start TREX: 

Log on as <sapsid>adm user. 

• To start TREX type TREX start. 

• To stop TREX (if necessary), enter TREX stop. 
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